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Glossary 

 

Term Definition 

Axis/Axes 
 Scan (also known as Y or Vertical) 

 Cross Scan (also known as X or Horizontal) 

Bleed 
Colors exceed the actual image boundary, causing a 
slightly blurred effect. 

Capping 
The maintenance tray closes onto the Printing Head 
plate, thereby protecting the heads from damage and 
drying out. 

Fixation Liquid 
Fixation spray, in liquid form, that is stored in the 
Fixation Spray tank. 

Fixation Spray 
Liquid that is sprayed onto the garment before the 
actual printing process. 

Garment 
Refers to any fabric that is mounted on the printing 
pallet and printed on. 

Ink Subsystem Secondary ink tank. 

Lint-free Towels 
Cleaning towels that are supplied by Kornit. 
Part number: 01-WIPR-0909. 

Magnetic Frame 
Metal frame that fits over the edges of the printing pallet 
and holds the garment in place during the printing 
procedure. 

Media The material on which you print your Breeze jobs. 

Negative air 
pressure 
(Vacuum) 

Applied to the print heads to prevent unwanted ink from 
dripping onto the media. 
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Term Definition 

Nozzle Test 
Procedure for determining which, if any, nozzles are not 
functioning properly. 

Orifice Plates The flat print head surface. Contains 256 nozzles. 

Pallet Base 
Fixed flat surface that serves as the basis onto which a 
printing pallet is installed. 

Pallet Positions 

 Home – For the printing pallet, the backside of the 
printer; for the print head carriage, the extreme right 
of the printer. 

 Loading – On the Cross Scan axis, the position 
closest to the user and from where you load the 
garment onto the printing pallet. 

Printer Stand The working surface upon which the Printer is placed. 

Purge 
Procedure for forcing small amounts of ink out through 
the nozzles to clear the print heads and/or prepare the 
print heads for printing. 

Spit 
Procedure for keeping the print heads unclogged and 
moist for printing. 

Wiping Fluid 
Cleaning agent supplied by Kornit and used for cleaning 
the water-based inks from such delicate printer parts as 
the print heads. Part number: 50-WIPG-0200. 
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Chapter 1:  

Introducing the Kornit Breeze  

The Kornit Breeze has been designed for inexpensive, high-speed, 
high-quality, multicolor, direct-on-garment printing. Together with 
Kornit's specially formulated ink, the easy-to-use Kornit Breeze system 
enables printing onto a wide range of garment types. The images are 
vividly colored and photo-realistic and feature high durability, UV 
resistance, and washability.  

Introducing the Kornit Breeze contains the following sections: 

 Overview on page 2. 

 Model Description on page 5. 

 Technical Specifications on page 16. 
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1 Overview  

Kornit Breeze is a lightweight, compact, print-to-garment digital printer 
that can be set up on a small table or simple metal frame. The system 
hooks up to any desktop or laptop computer that meets the standard 
requirements and can be operated from almost any location. 

The Kornit Breeze provides you with: 

 An enhanced printing arrangement that simultaneously runs color 
and white print heads, enabling greater printing speed and higher 
throughput. 

 A Touch Pad screen console for quick and easy machine 
maintenance. 

 An automatic pre-treatment system. 

 An automatic pre-treatment, wiping system. 

 An automatic maintenance station that saves head cleaning time 
and improves reliability. 

 An integrated degassing system that enables a smooth and 
uninterrupted ink flow. 

 Vertical height adjustment of up to 2 cm, enabling high-quality, non-
contact printing for thick garments and such special garment 
applications as seams, pockets etc. 
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2 Before You Begin 

Getting to know the documentation conventions  

The following safety symbols are used throughout all Kornit Breeze 
documentation. Familiarize yourself with the symbols and their 
meaning before operating the printer: 

 

WARNING! 

A WARNING denotes a hazard. It calls attention to a procedure that, if not 
correctly performed or adhered to, could result in injury or loss of life. Do not 
proceed beyond a warning note until the indicated conditions are fully 
understood and met. 

 

 

CAUTION! 

A CAUTION denotes a hazard. It calls attention to a procedure that, if not 
correctly performed or adhered to, could result in damage or destruction of the 
instrument. Do not proceed beyond a caution sign until the indicated conditions 
are fully understood and met. 

 

 

NOTE: 

A NOTE calls attention to important issues of which you should be aware. 

 

Getting to know the terminology 

Some words appearing in this guide are generic to the printing industry 
while other words are specifically used by Kornit. 

Read over the Glossary on page vii to become familiar with these 
terms. 
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3 Safety Information 

Getting to know the printer hazards 

 Moving Parts:  

 Printing pallet, print head assembly, wiper assembly, and the 
maintenance tray. 

 The front hood, service doors and side guards. 

 

WARNING! 

You must set the magnetic frame correctly in place before activating print 
head and/or the printing pallet movement. If the printing pallet is not in 
place, you can cause severe damage to the print heads. 

 

 Electrical Parts – Wiring, Circuit Breaker (CB1) on page 14. 

 Hot Parts – Print Heads 

 Single Print Button 

 

WARNING! 

This printer has a single green Start button. Keep your hands clear of all 
moving parts when you press the button to start the printer. 
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4 Model Description 

 

Figure 1: Breeze Digital Printer  

The Model Description section describes the various printer views: 

 External Front of the Printer on page 6. 

 Internal Front View on page 8. 

 Internal Left Side View on page 9. 

 Internal Rear View on page 10. 

 External Right Side View on page 11. 

 Internal Right Side View on page 12. 

In addition, the Model Description section describes: 

 Printer Table (Optional) on page 13. 

 Safety Features on page 14.  

 Technical Specifications on page 16. 
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4.1 External Front of the Printer 

 

 
Figure 2: Front View  

From the front of the Kornit Breeze, when the front hood is closed, you 
can see the following elements: 

 Front Hood – Clear, plastic cover that protects the ink, pneumatic, 
motion, and electronic systems from unwanted dirt and contact. 

 Printing Pallet – Surface onto which you place the garment for 
printing.  

 Start Button – Single green button that starts the printing process. 

 LCD Maintenance Panel – Provides you with an ongoing visual 
report of the system and allows you to perform various 
maintenance activities.  

 Emergency Stop Button – Enables you to immediately stop printer 
activity.  

 
 
 
 
 
 
 
 
 
 
 

Emergency 
Stop 

Button 
 

 
Front Hood 
 
Print Head 
Assembly 
Cover 
 
Printing 
Pallet 
 

Start Button 

LCD 
Maintenance 
Monitor 
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4.2 Internal Front View 

 

Figure 3: Internal Front View 

Inside the front of the Kornit Breeze, you can see the following 
elements: 

 Print Head Assembly - Injects the ink onto the media. 

 Maintenance Tray – Collects all excess ink and directs it to the 
waste ink container. In addition, the maintenance tray enables 
performing such maintenance activities as capping, and purge and 
wipe.  

 Scan Axis – Axis along which the print head assembly moves. 

 Cross Scan Axis – Axis along which the printing pallet moves.  

Print Head 
Assembly 
 
 
Maintenance 
Tray 
 
 
 
 

 

 

Scan Axis 

  

Cross Scan 
Axis 

Printing Pallet 
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4.3 External Left Side View 

 

Figure 4: External Left Side View 

From the left side of the Breeze, you can see the following elements: 

 Left service door and door latch. 

 Main switch and power connection. 

 Front hood. 

 Left guard. 

 Emergency stop button. 

 

WARNING! 

After pressing the Emergency Stop button, the power supply is still active. 

 

 

 
Front Hood 
 
 
 
 
Left Guard 
 
 
Emergency 
Stop 
Button 

 
 
 

Left Service 
Door 

 

Door Latch 
 
 

Main Switch 
and Power 

Connection 
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4.4 Internal Left Side View 

 

Figure 5: Internal Left Side View 

From the left side of the Kornit Breeze, through the left service door, 
you can see and access the following elements: 

 Circuit Breaker (CB1) – Main power circuit breaker. 

 Pneumatic Assembly – Includes such pneumatic and spray 
components as pumps, valves, gauges, etc.  

 Fixation Spray Bottle – Container holding the fixation liquid that is 
sprayed onto the garment before printing. 

 
Main Circuit 

Breaker 
 

Pneumatic 
Assembly 

 
Fixation 

Spray Bottle 
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4.5 Internal Rear View 

 
Figure 6: Internal Rear View 

The back of the printer is covered and access is limited to technicians 
only. Inside the rear of the Breeze, you can view the electronic 
assembly, which includes such electrical components as electronic 
cards, drivers, power supply etc. 

 
Electronic 
Assembly 
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4.6 External Right Side View 

 
Figure 7: External Right Side View 

From the right side of the Breeze, you can see the following elements: 

 Right service door. 

 Waste ink tube – Transports ink wastes from the maintenance tray 
to the waste ink container. 

 Waste ink Container – Collects ink wastes from the maintenance 
tray through the waste ink tube. 

 
 
Right 
Service 
Door 
 
 
 
 
 
 
 
Waste Ink 
Tube 

Waste Ink 
Container 
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4.7 Internal Right Side View 

 
Figure 8: Internal Right Side View 

From the right side of the Breeze, you can see: 

 The Ink Service Compartment – Houses the ink bottles. 

Ink Service 
Compartment 
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4.8 Printer Table (Optional) 

 

Figure 9: Table Assembly 

The printer stand assembly consists of the following parts: 

 Rectangular legs. 

 Table levelers.  

 Nut and bolt sets. 

 Print Placement Points – Six location points for fitting the printer 
legs. 

 
Nuts and bolts 
 
 
 
Rectangular Legs 
 
 
 
 
 
 
 
 

Table Levelers 

Printer 
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Points 
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4.9 Safety Features 

The printer has been designed with the following safety features: 

 Circuit Breaker (CB1) on page 14. 

 Emergency Stop on page 15. 

 Protective Covers on page 15. 

 Interlock on page 15. 

4.9.1 Circuit Breaker (CB1) 

The circuit breaker (CB1) is located at the rear-left of the printer. All 
system operation immediately shuts down when the circuit breaker 
shuts off.  

 
Figure 10: Circuit Breaker 

 To restart the circuit breaker: 

1. On the left service door, press the door latch button; the door latch 
handle pops out. 

2. Pull on the handle to open the service door. 

3. Carefully reach your hand up to the circuit breaker. Make sure that 
you do not touch anything else in that compartment. 

4. Push up the circuit breaker switch; I.ON appears in the circuit 
breaker status window. 

5. Close the service door and press the door latch button to lock the 
door. 

Circuit Breaker (CB1) 

 
Circuit Breaker Status 
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4.9.2 Emergency Stop 

The Emergency Stop button is located on the front printer panel, to the 
left of the printing pallet. Press the Emergency Stop button to 
immediately stop machine operation. 

 

 

 

 

Figure 11: Emergency Stop Button – On Position  Figure 12: Emergency Stop Button – Off Position 

4.9.3 Protective Covers 

The printer is equipped with the following protective covers:  

 Front Hood – Hinged and supported by two gas springs. Attached 
to an interlock. See Interlock on page 15.   

 Left and Right Side Guards – Hinged to enable opening and/or 
removing during repairs and maintenance. 

 Back Cover – Closes the back side of the printer. Can only be 
opened by a technician. 

 Left and Right Service Doors – Transparent plastic and opened 
using a pop-handle locking system. 

 Print Head Assembly Cover – Completely covers and seals the 
print head assembly. Only technicians are allowed to open the 
cover in order to service the print head assembly. 

4.9.4 Interlock 

The printer is equipped with an interlock on the Front Hood. All system 
operation is immediately shut down when the Front Hood is opened. 
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4.10 Technical Specifications 

 

 

Type Description 

Printing Method Drop-on-Demand, Direct-to-Garment: Computer to Garment 

Ink Type Proprietary pigmented water-based ink 

Print Heads 
Spectra Piezo Electric, 6 heads, 5 colors, 256 nozzles per 
head 

Image Print Size Up to 14"x18" (35x45cm) 

Colors 
4 CYMK colors for light and dark garments, and white for 
dark garments 

Resolutions  
600dpi x 1600dpi, 600dpi x 1200dpi, 600dpi x 800dpi, 
600dpi x 600dpi 

Printed Media 
Cotton, Polyester, Cotton-Polyester blends, Lycra, Viscose, 
Silk, Leather, Denim, Linen, Wool and more 

File Preparation and 

RIP 
QuickP  

Operating System Windows XP, Windows 7 

Image Data 

Input: All conventional graphic file formats (e.g. TIFF, PNG, 
JPG, PSD etc.) 

Output: TIFF, PPI, TIFF, and BITMAP 

Throughput (for A4 

image size) 

Light Garments: Up to 40 shirts per hour 

Dark Garments: Up to 25 shirts per hour 

Interface Network (Ethernet TCP/IP) 

Power Requirements 
Electrical supply: Single phase 220-240V / 110-120V,  
50/60 Hz 

Operating Conditions Temperature: 18
o
c-30

o
c, Humidity: 45%-90%.  

Dimensions 1.14m length x 1.5m width x 0.70 m height. 

Weight Approx. 210 kg/463 lbs. 

Number of Operators 1 
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5 Graphical User Interface 
Description 

The Graphical User Description section describes the major windows 
found in the Kornit Breeze software and includes: 

 Main Window on page 18. 

 File Details Window on page 22. 

 Setup Editor on page 26. 

 Technician Window on page 44. 

 Menu Bar Navigation Chart on page 51.  

 

NOTE: 

You can only open a single Kornit Breeze application at any one time. 
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5.1 Main Window 

 

Figure 13: Main Window 

The Main window immediately appears when you open the Breeze 
application. 

The Main Window is composed of the following elements: 

 Job Queue on page 19. 

 Menu Bar. See the Menu Bar Navigation Chart on page 51.  

 Messages Area on page 20. 

 Spray Level Indicator on page 20. 

 Preview Area on page 20. 

 Job Information Panel on page 20 . 

 Command Buttons on page 20. 

Menu Bar 
 
 
 
 
 
 
 
 
 
 

Job Queue 
 
 
 
 
 
 
 
 
 

Messages 
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Preview Area 
 
 
 
 
 
 
 

Job Information Panel 
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Secondary Ink Tank 
Levels 

Command Buttons 
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5.1.1 Job Queue 

 
Figure 14: Job Queue 

The job queue lists the job files that have been loaded to the 
workstation and indicates the processing status of each file. From the 
job queue, you can:  

 Upload and delete job files. 

 Rearrange the order of the job files in the queue. 

 Load lists of files into the queue. 

 View and enable/disable the spray and wipe procedures. 

 View the following preset file properties:  

 File Name. 

 The number of copies being printed. 

 The selected media to be used. 
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5.1.2 Messages Area 

The Messages area displays a variety of system messages while the 
printer is operating. 

5.1.3 Spray Level Indicator 

The Spray Level Indicator shows whether or not there is sufficient 
spray to treat the next several garments. When the spray level is low, 
the indicator appears as an empty spray tank.  

5.1.4 Secondary Ink Tank, Ink Level Indicators 

The Secondary Ink Tank, Ink Level Indicators show the current level of 
the ink in each Secondary Ink Tank.  

 – Indicates that there is sufficient ink, in the specific Secondary Ink 
Tank, to perform printing procedures. 

 – Indicates that there is insufficient ink, in the specific Secondary 
Ink Tank, to perform printing procedures. 

5.1.5 Preview Area 

The Preview Area enables you to preview the image before printing. 

5.1.6 Job Information Panel 

The Job Information Panel displays the following information: 

 Job Setup information: 

 Setup – Setup name. See Modifying File Detail Parameters on 
page 23. 

 Media – Media name. See Modifying the Job Setup on page 25. 

 Pallet information: 

 Pallet – Printing pallet name. 

 Height – Distance (in mm) between the print heads and the 
media as defined in the Media DB and according to the Media 
Name selection. 
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5.1.7 Command Buttons 

The Command Buttons are: 

  – The Print button starts the printing process. You can 
also start the printing process by pressing the green print button on 
the printer.  

 

NOTE: 

Start printing only after you have configured the printing parameters for the 
specific job and have placed the garment on the printing pallet. 

 

  – The Stop button aborts the printing process; the print 
heads move into the service area and the printing pallet moves 
back (towards you) to the loading position. 
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5.2 File Details Window 

To print a job, you must first upload one or more image files to the job 
queue. When you upload an image file to the job queue, the File 
Details window appears. 

 To access the  window: 

1. From the Main Window, in the job queue, click New File; the Open 
window appears. 

2. Select the appropriate job file and click Open; the File Details 
window appears. 

 
Figure 15: File Details Window  

From the File Details window, you can perform: 

 Modifying File Detail Parameters. See page 23. 

 Modifying the Job Setup. See page 25. 
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5.2.1 Modifying File Detail Parameters 

Every printed garment and job has specific characteristics that require 
different treatment. To deal with these differences, you can modify the 
following File Details parameters:  

 Setup Name – The name that signifies the specific setup.  When 
you change setup parameters, the system enables you to name the 
new setup. See Setup Name on page 28. 

 Copies – The number of garments to be printed with this specific 
image. 

 X and Y Offset – The position of the image in the Preview pane. 
This will be the position of the print on the garment. 

 Select the Center checkboxes to center the image along the X 
and Y axes of the Preview area. 

 Width and Height – The size of the image in the Preview pane. This 
will be the width and height of the print on the garment. 

 Select the Keep the Ratio checkbox to maintain relative 
width/height proportions when changing either the width or the 
height. 

 Rotate and Mirror: 

 Rotate the image clockwise 90 degrees. 

 Rotate the image clockwise 180 degrees. 

 Create a mirror image of the original image. 

 Spray Amount – The amount of fixation spray to be applied to the 
garment. 

 Select the Spray checkbox to apply the fixation spray before 
printing. 

 Select the Wipe checkbox to wipe the garment after applying 
the fixation spray. 
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 White Print and Highlight Mode – See White Print and Highlight 
Mode on page 32. 

 

NOTE: 

The File Details window includes the following tools that can assist you 
when modifying the setup parameters: 

 File Details Pane – Displays all of the selected setup properties and 
values. 

 Preview Pane – Displays the uploaded image. 

 Preview Options Panel – Enables viewing changes to the parameters 
without specific color layers. 

 

After defining the file detail parameters, you click OK to save the 
parameters and to continue with the print procedure. 

 

NOTE: 

Changes to Spray, Wipe, Copies, and Mode parameters are displayed in the 
job queue. 
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5.2.2 Modifying the Job Setup 

Use the File Details window to adjust the file detail parameters of the 
specific job only. Use the Setup Editor to create new job setups or to 
modify existing job setups. See Setup Editor on page 26.  

File Detail parameters include:  

 White Print Mode options: 

 None – White colors are not printed 

 Single – One layer of white color is printed. 

 Double – Two layers of white color are printed. 

 Additional Layer – An additional layer of white color is printed, as a 
highlight. 

 White Color Adjusters. See Defining White and Highlight Layers on 
page 33.  

 

NOTE: 

 When selecting a WhiteT setup name for a light-color garment, all of 
the White Print Mode options will appear as 'Disabled'.  

 When you select "None" as the White Print Mode option, all opacity 
options are disabled. 

 When you move a slider, all sliders below it move together with it. 
 

After defining the File Details parameters, click OK to save the 
parameters and to continue with the print procedure.  
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5.3 Setup Editor 

 

Figure 16: Setup Editor Window 

The Setup Editor enables creating and saving new job setups. 

Setup Editor comprises the following panels: 

 Setup Details on page 27. 

 Photoshop Actions on page 30. 

 White Print and Highlight Mode on page 32. 

 Color Setting on page 36. 

 Remove Black Ink on page 38. 

 Image Sharpener on page 38. 

 Time Control and Print Direction on page 38. 

 Setup Control Buttons on page 39. 
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5.3.1 Setup Details 

 
Figure 17: Setup Details Panel 

The Setup Details panel comprises the following elements: 

 Setup Name – Dropdown list for selecting a predefined job setup 
that is stored in the Setup database. See Setup Name on page 28. 

 

NOTE: 

The setup reflects all of the parameters defined in the Setup Editor.  
 

 Media Name – Dropdown list for selecting a predefined media that 
is listed in the Media database.  

 When you select a media name, you also select the associated 
Dark Media, Spray Amount, and LUT (which includes 
resolution) settings that you set in the Media Database window. 

 See Media Name on page 29 and Configuring Media Database 
Operation Parameters on page 118. 

 Go to Media DB button – Accesses the Media Database window 
and enables creating and modifying media parameters. 

 Print Speed: 

 High Production – For printing on light-colored garments, using 
CMYK colors. 

 Production – Default, recommended speed. 

 High Quality – For printing small images (e.g. on pockets and 
hats). 

 Spray Amount – Enables selecting the amount of spray to apply to 
the garment, in a percentage.  
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 Spray and Wipe checkboxes – Enable applying and wiping the 
spray. 

 

NOTE: 

When you clear the Spray checkbox, the Wipe checkbox is also cleared. 
 

Setup Name  

A setup name represents a predefined job setup file stored in the Setup 
database.  

Kornit provides the following list of default job setup files which can be 
used as is or which can serve as the base for new job setup files 
tailored to your specific needs. 

For Black T Shirts: 

 BlackTDefault – For RGB transparent images, 600x600, High 

Production, Double White, 50% Sharpen with ICC profile. 

 BlackTManual – For CMYK-WH images, 600x600, High Production, 

Double White, 50% Sharpen, no action, no ICC profile. 

 BlackT_BlackBackground - For RGB transparent images, 600x600, 

High Production, Double White, 10% Remove Black Ink, 50% 
Sharpen with ICC profile. 

For White T Shirts: 

 WhiteTDefault – For RGB images, 600x600, High Production, 60% 
Sharpen with ICC profile. 

 WhiteTInterlace - For RGB images, 600x600, High Production, 
Including Interlace, 60% Sharpen with ICC profile. 

 WhiteTManual - For CMYK images, 600x600, High Production, 

60% Sharpen, no action, no ICC profile. 

For Calibration: 

Calibration – For printing 1 Bit images of the calibration wizard. 
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Media Name 

Jobs can be printed on a wide selection of media definitions and these 
definitions are stored in the Media Database (see Managing the Media 
Database on page 120). Your system has been installed with a number 
of ready-made media definitions, which you can use, or you can create 
new definitions, as required. 

When creating new definitions, we recommend that the Media Name 
indicate the specific elements that make up the selected media. 

For example, name new media definitions according to: 

 The type of media. 

 Specific elements in the media (e.g. spray amount, LUT, Light or 
Dark Media). 
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5.3.2 Photoshop Actions 

 
Figure 18: Photoshop Actions Panel 

The Photoshop Actions panel comprises a dropdown list of all 
pre-defined Photoshop actions, stored in the Photoshop Actions 
Database.  

 

NOTE: 

 Photoshop must be installed on your computer to use this option. 

 When selecting a Photoshop Action, all Color Setting options are disabled.  

 

Photoshop Actions are activities performed sequentially in Photoshop 
software which is running in the background of the Breeze application. 

The name of the Photoshop Action indicates the various activities that 
are performed within the action. 
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Photoshop Action name example: BlackTMidFullFrameStroke 

 Name Element Indicates 

1 LightT Does not prepare a white layer. 

DarkT Prepares a uniform white layer under the 
CMYK colors. 

BlackT Creates a gradient white layer according to the 
details in the image. 

2 Skinetone For photorealistic and high detail images. Best 
for portrait and skin tones. 

Normal Preserves the details and original colors, 
optimizes the colors to suit the Kornit printer. 

Mid Optimizes the colors, while attempting to 
preserve the original details. Most suitable for 
bright colors. 

High Optimizes the colors (more than Mid), while 
attempting to preserve the original details. 
Most suitable for bright colors. 

3 FullFrame For non-transparent files such as .jpg. Suited 
to full frame pictures, landscape, family, etc. 

Stroke Prints a two pixel sideline around the image, to 
sharpen the image and cover white layer 
edges. 

 



32  Kornit Breeze User Guide 

Last printed: 1/11/2012 4:38:00 PM 

Last saved: 1/11/2012 4:38:00 PM 

5.3.3 White Print and Highlight Mode 

 
Figure 19: White Print and Highlight Mode Panel 

White print and highlights are defined in the Job Setup. The White Print 
and Highlight modes panel enables you to optimize the quality of your 
image on a dark or black-colored media, when there is need (e.g. when 
changing the media). 

White Print Mode comprises the following elements: 

 White Print   

 None – White colors are not printed. 

 Single – One layer of white color is printed. 

 Double – Two layers of white color are printed. 

 

NOTE: 

When you select "None" as the White Print Mode option, the White 
Highlight [%] are disabled. 

 

 White Color Adjusters – Adjust white color opacity.  

 Additional Layer – Add an additional layer of white is printed as a 
highlight. 

 Print White Areas option – Select to print visible white areas. 
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 To work with the White Print Mode, see the following 

descriptions: 

 Defining White and Highlight Layers on page 33. 

 Adjusting White Opacity – Without an Additional Highlight Layer on 
page 34 

 Adjusting White Opacity – With an Additional Highlight Layer on 
page 35. 

Defining White and Highlight Layers 

Use the following chart to help in selecting the number of white and 
highlight layers.  

Purpose  Select Settings Results 

Single White 

 High 
production 
printing 

 Normal 
quality  

3. Single White 
Print Mode 

One printed layer: 

1. White and CMYK 

Double White 
(Default) 

 Production 
printing 
quality 

 

4. Double White 
Print Mode 

Two printed layers: 

1. White 

2. White and CMYK 

Single White 
and Highlight 

 Production 
printing 
quality 

 

 Single White 
Print Mode 

 Additional White 
Highlight Layer 

Two printed layers: 

1. White 

2. Highlight and 
CMYK 

Double White 
and Highlight 

 Low 
production 

 High 
quality  

 Double White 
Print Mode 

 Additional White 
Highlight Layer 

 

Three printed layers: 

1. White 

2. White 

3. Highlight and 
CMYK 
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Adjusting White Opacity – Without an Additional 
Highlight Layer 

When you clear the "Additional Layer" option, the white highlight layer 
is combined with and printed as part of the white layer. Use the sliders 
to control white color opacity. 

 The White Highlight (%) slider controls the opacity of the white 
areas beneath CMYK colors of 0-5% opacity. 

 The White Under Light Colors (%) slider controls opacity of the 
white layer that is printed underneath light colors. 

 The White Under Light Colors slider position determines the 
maximum amount of white that can appear under a light CMYK 
color that has 5-100% opacity. 

 The White Under Dark Colors (%) slider controls opacity of the 
white layer that is printed underneath dark colors.  

 The White Under Dark Colors slider position determines the 
minimum amount of white that can appear under a dark CMYK 
color that has 5-100% opacity. 

 

 

NOTE: 

When you move a slider, all sliders, below the specific slider, move together. 

 

White Layer 
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Adjusting White Opacity – With an Additional Highlight 
Layer  

When you select the Additional Layer option, the system distinguishes 
between the white highlight layer and the white under layer and prints 
the Highlight Layer as an additional layer together with the CMYK layer. 
Use the sliders to control white color opacity. 

 The White Highlight (%) slider controls the opacity of the highlight 
white areas above CMYK colors of 0-5% opacity. The White 
Highlight is printed as an additional layer. 

 The White Under Light Colors (%) slider controls opacity of the 
white layer that is printed underneath light colors. 

 The White Under Light Colors slider position determines the 
maximum amount of white that can appear under a light CMYK 
color that has 5-100% opacity. 

 The White Under Dark Colors (%) slider controls opacity of the 
white layer that is printed underneath dark colors.   

 The White Under Light Colors slider position determines the 
minimum amount of white that can appear under a dark CMYK 
color that has 5-100% opacity. 

 

 

NOTE: 

The 'White Highlight' slider moves independently of the other sliders. When 
you move the 'White under light color' slider, the 'White under dark color' slider 
moves together with it. 

 

Highlight Layer 
 
 
 

White Layer 
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5.3.4 Color Setting 

 
Figure 20: Color Setting 

Use Color Setting, in place of Photoshop actions, to convert RGB and 
CMYK colors to Kornit CMYK colors, to define color saturation, and to 
define the Color Print mode. 

Color Setting comprises the following industry-standard elements: 

 RGB Source profile:  

 Adobe RGB 1998.icc (default) 

 sRGB Color Space Profile.icm 

 CMYK Source profile: 

 EuroscaleCoated.icc 

 Photoshop5DefaultCMYK.icc 

 UncoatedFOGRA29.icc 

 USWebCoatedSWOP.icc (default) 

 USWebUncoated.icc 

 Rendering Intent (Standard rendering types): 

 Perceptual (default) – Preserves some relationship between 
out-of-gamut colors, even if this results in inaccuracies for 
in-gamut colors. 

 RelativeColorimetric – Maintains a near exact relationship 
between in-gamut colors, even if this clips out of gamut colors. 

 Saturation – Preserves saturated colors and is most useful 
when for retaining color purity in graphics when converting into 
a larger color space. 
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 AbsoluteColorimetric – Similar to Relative Colorimetric (in that it 
preserves in-gamut colors and clips those out of gamut) but 
preserves the white point, the location of the purest and lightest 
white in a color space.  

 Output Profile: 

 Kornit_Black_Darker.icm  Kornit_White_Darker.icm 

 Kornit_Black_Darker2.icm  Kornit_White_Darker2.icm 

 Kornit_Black_Lighter.icm  Kornit_White_Lighter.icm 

 Kornit_Black_Lighter2.icm  Kornit_White_Lighter2.icm  

 Kornit_Black_Normal.icm  Kornit_White_Normal.icm (default) 

 Kornit_Black_Normal2.icm  Kornit_White_Normal2.icm 

 Color Print Mode enables selecting the following color print options: 

 None – CMYK colors are not printed; only the selected white 
layer is printed. 

 Single – One layer of CMYK color is printed. 

 Interlace – Two layers of CMYK color are printed in two passes, 
enabling perfect ink coverage. 

 Saturation: 

 Lighter – A lighter than normal color saturation level. 

 Normal – The normal color saturation level. 

 Darker – A darker than normal color saturation level. 
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5.3.5 Remove Black Ink 

 
Figure 21: Remove Black Ink Panel 

Remove Black Ink enables progressively removing black or dark RGB 
colors from the image. 

5.3.6 Image Sharpener 

 
Figure 22: Image Sharpener Panel 

Image Sharpener enables progressively improving image detail.  

5.3.7 Time Control and Print Direction 

 
Figure 23: Time Control and Print Direction Panel 

Time Control enables controlling the time lapse between print 
processes and comprises the following elements: 

 Delay spray to print – The time delay, in seconds, between the end 
of the spray procedure and the start of the print procedure. 

 Delay between white layers – The time delay, in seconds, between 
printing the first and second layers of white color. 

 Delay between white and color –The time delay, in seconds, 
between printing the white color layer and printing the CMYK color 
layer. 
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Direction enables controlling the direction of the print and comprises 
the following elements: 

 UniDirectional – Print in one direction only. 

 BiDirectional –Print in both directions (front-to-back and  
back-to-front). Suitable option for printing an image: 

 On a garment that has a consistent thickness. 

 On the thinnest part of a garment (where the garment has a 
thicker area due to pockets, buttons, etc.). 

 On the thickest part of the garment (e.g. on a pocket). 

5.3.8 Setup Control Buttons 

The Setup Editor provides the following controls: 

 Save – Enables creating and saving new setup files to the Setup 
database and enables modifying setup files stored in the Setup 
database. See Creating New Setup Files on page 80 and Modifying 
Existing Setup Files on page 82. 

 Delete – Enables deleting setup files from the Setup database. See 
Deleting Existing Setup Files on page 84. 

 Import – Enables importing setup files to the Setup database. See 
Importing Setup Files on page 85. 

 Export – Enables exporting setup files from the Setup database. 
See Exporting Setup Files on page 87. 
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5.4 Operator Window 

From the Operator window, you can perform maintenance activities to 
the ink, spray, and motion system. See Maintaining the Printer from the 
Operator Window on page 176. 

 To open the Operator window: 

From the Main Window, click Maintenance > Operator; the Operator 
window appears.   

 
Figure 24: Operator Window  

The Operator window includes: 

 Operation Indicators on page 41. 

 Manual Activity Buttons on page 42. 

 Maintenance Tray and Axis Movement Controls on page 43. 

 Heads to Purge Controls on page 43. 
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5.4.1 Operation Indicators 

The Operation Indicators provide you with a continuous status overview 
of the following: 

 Secondary Ink Tank Ink levels – When a Secondary Ink Tank has 
an insufficient amount of ink for printing, the ink level indicator is 
displayed with an exclamation mark. 

 

 

 
Figure 25: Secondary Ink 

Tanks (Sufficient ink levels) 

 Figure 26: Secondary Ink Tanks 

(Insufficient ink levels) 

 Air System – A red indicator light indicates that the vacuum is out of 
defined range.  

 Print Head temperatures – A red indicator light, adjacent to PH 
Temp, indicates that the print head work temperature is out of the 
defined range. See Head Properties on page 44.  

 Counters – The upper figure indicates the number of prints since 
Reset button was last clicked. The lower figure indicates the total 
number of prints produced by the printer. 

 
Figure 27: Counters Pane 
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5.4.2 Manual Activity Buttons 

The Manual Activity buttons enable you to perform: 

 Purge – Release ink, under pressure, to open a clogged nozzle. Ink 
is released only through print heads that have been selected in the 
Heads to Purge panel. See Heads to Purge Controls on page 43.   

 Purge & Wipe – Release ink, under pressure, to open clogged 
nozzles, clean the print heads, and/or prepare the print heads for 
printing. See Performing Print Head Purge on page 205 and 
Manually Performing Purge and Wipe on page 206. 

 Spray All – Spray the garment before printing.  When you click the 
Spray All button, the Spray All window appears: 

 

From the Spray All window, you can redefine: 

 Spray amount (in a percentage). 

 Wiping – Select the checkbox to enable wiping. 

 The spray area:  

 Select the Current Job Area checkbox to spray the job area 
only. 

 Clear the Current Job Area checkbox to spray the entire 
printing pallet area. 

 Spit – Perform the Spit process to keep the print heads moist and 
unclogged. 

 Nozzle Test – Perform either a color (default) or white nozzle test. 
See Performing a Nozzle Test on page 68. 

 
WARNING! 

When you perform a Nozzle Test, the printing pallet immediately moves without 

pressing the Start button. 
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5.4.3 Maintenance Tray and Axis Movement 

Controls 

Maintenance Tray and Axis Movement controls enable you to perform 
the following activities:  

Maintenance Tray 
 Capping – Move the maintenance tray upwards until the tray is 

sealed under the print heads. Capping protects the print heads 
from lint and other foreign material and keeps the print heads moist 
during long pauses in the printing process. 

 Wipe – Move the maintenance tray until the tray wipers are at the 
same level as the print heads. This position is used automatically to 
wipe the print heads and clean off excess ink.  

 Spit – Move the maintenance tray to a height position where the 
maintenance tray does not interfere with printing pallet movement 
but is still high enough to catch ink fired from the print heads during 
the Spit procedure.  

 Down – Move the maintenance tray downwards to the lowest 
position possible. 

Move Axes 
 Home – Move the printing pallet and the print head carriage along 

their respective axes to their Zero positions (note that the Scan 
Zero position is at the back of the printer, furthest away from the 
operator). 

 Load Position – Move the printing pallet to the Cross Scan Axis 
position closest to you. 

5.4.4 Heads to Purge Controls 

Use the Heads to Purge checkboxes to select specific print head air 
valves to be purged or use Select All or Close All buttons to select all 
the air valves at the same time. 
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5.5 Technician Windows 

Technicians and operators with special Kornit permission (see 
Activating the Technicians Mode on page 112) can use the Technician 
windows to configure, repair, and test the system.  

5.5.1 Head Properties 

From the Technician/Head Properties window, you can monitor the ink 
levels and print head temperatures and configure the print head 
temperatures, pulse width, and bias.  

 To open the Technician/Head Properties window: 

1. From the Main Window, click Maintenance > Technician; the 
Technician window appears.  

2. Select the Head Properties tab; the Head Properties view appears. 

 
Figure 28: Technician/Head Properties Window 
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From the Technician/Head Properties window you can also perform: 

 Ink Reset – Reset the ink level indicator and activate the pump 
when the ink level is low. 

 Spray Pump – Manually activate the fixation spray pump for testing 
purposes. 

 Spray Wiper – Manually activate the spray wiper for testing 
purposes. 
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5.5.2 Axis Properties 

From the Technician window/Axis Properties view, you can manually 
move the printing pallet, print heads, and maintenance tray along their 
respective axes. This enables you to align these parts in order to 
calibrate the most suitable distances between the printing pallet and 
the print heads, and between the maintenance tray and the print heads. 

 To open the Axis Properties view: 

1. From the Main Window, click Maintenance > Technician; the 
Technician window appears. 

2. Click Axis Properties; the Axis Properties view appears. 

 
Figure 29: Technician Window/Axis Properties 
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From the Axis Properties view, you can: 

 Move the Cross Scan axis to: 

 Home position. 

 Load position. 

 A new position, relative or absolute, to the present Cross Scan 
position. 

 Move the Scan axis to:  

 Home position. 

 Capping position. 

 A new position, relative or absolute, to the present Scan 
position. 

 Move the Z axis to the following positions: 

 Capping. 

 Wipe. 

 Spit. 

 Down. 

 View the current position of each axis. These fields automatically 
update as the axes are moved. 

 

NOTE: 

The current position of each axis (the Encoder parameter): 

 Is registered by the system while the machine is operating. 

 Cannot be changed. 
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 To move the printing pallet along the Cross Scan axis to a 

predefined position: 

From the Technician/Axis Properties window, in the Scan Axis pane, 
click one of the following position buttons: 

 Home – The print head carriage (scan axis) and the printing pallet 
(cross scan axis) move to their zero positions (i.e. Cross Scan Zero 
position is at the back of the machine while the Scan Zero position 
is at the right side of the machine). 

 Load Position – The printing pallet moves to the position closest to 
you, from where you load the garment. 

 To move the printing pallet, along the Cross Scan axis, to a 

selected position: 

From the Technician/Axis Properties window, in the Cross Scan Axis 
pane, click one of the following optional tabs: 

 Relative: 

 Enter the positive number of microns that you want to move the 

printing pallet; click the Up or Down arrow buttons to initiate 
movement. The printing pallet moves according to the number 

of microns that you entered into the field. Click the Stop button 

 to end printing pallet movement. 

 Absolute: 

 Enter the position (as a positive value) to where you want to 

move the printing pallet. Click the Start button; the printing 
pallet moves to the position that you specified. Click the Stop 

button  to end printing pallet movement. 

 
Figure 30: Technician Window/Axis Properties/Absolute Position 

Start 
Button 

Absolute Position Field 
 
Stop Button 
 
 
Encoder Position 
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NOTE: 

The Absolute position of the Cross Scan axis appears in the Encoder Position 
field and is automatically updated as the axis moves. 

 

 To move the print head carriage, along the Scan axis, to a 

predefined position: 

From the Technician/Axis Properties window, in the Scan Axis pane, 
click one of the following position buttons: 

 Home – The print head carriage moves to the zero position, located 
on the right side of the axis. 

 Capping Position – The print head carriage moves across the Scan 
Axis to the Capping position. 

 To move the print head carriage, along the Scan axis, to a 

selected position: 

From the Technician/Axis Properties window, in the Scan axis pane, 
click one of the following optional tabs: 

 Relative: 

 Enter a positive number of microns that you want to move the 

printing pallet; click the Left or Right arrow buttons to initiate 
movement. The printing pallet moves according to the number 

of microns that you entered into the field. Click the Stop button 

 to end printing pallet movement. 

 Absolute: 

 Enter the position (as a positive value) to where you want to 

move the printing pallet. Click the Start button; the printing 

pallet moves to the position that you specified. Click the Stop 

button  to end printing pallet movement. 
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 To move the maintenance tray to various up and down 

positions: 

From the Technician/Axis Properties window, in the Scan Axis pane, 
click one of the following position buttons: 

 Capping – Move the maintenance tray upwards until the tray is 
sealed under the print heads. Capping protects the print heads 
from lint and other foreign material and keeps the print heads moist 
during long pauses in the printing process. 

 Wipe – Move the maintenance tray until the tray wipers are at the 
same level as the print heads. This position is used automatically to 
wipe the print heads and clean off excess ink.  

 Spit – Move the maintenance tray to a height position where the 
maintenance tray does not interfere with printing pallet movement 
but is still high enough to catch ink fired from the print heads during 
the Spit procedure.  

 Down – Move the maintenance tray downwards to the lowest 
position possible. 
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5.6 Menu Bar Navigation Chart 

 

 

 
Figure 31: Menu Bar Navigation Chart 
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Chapter 2: 

Operating the Printer 

Operating the Printer describes all of the pre and post operation 
procedures that you should perform each working day: 

The Operating the Printer chapter describes the procedures for: 

 Preparing the System for a New Work Day on page 54. 

 Closing the Printer after a Workday on page 68. 

The Operating the Printer chapter also includes the: 

 Breeze Daily Workflow Map on page 72.  

 

NOTE: 

Pre and post operation procedures are also known as Daily Maintenance 
Procedures: 

 We recommend that you keep a running record of these procedures. See 
the Daily Maintenance Checklist (for Work Day) on page 218 and the Daily 
Maintenance Checklist (for Work Shift) on page 219. 

 We also recommend that you perform additional maintenance procedures 
each week. See Weekly Maintenance Procedures on page 220. 
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1 Preparing the System for a New 
Work Day 

We recommend that you perform the following procedures before 
beginning to print your first jobs of the day or at the start of your shift.  

 Renewing the Ink Supply on page 55. 

 Activating the Printer on page 57. 

 Refilling the Fixation Spray on page 61 

 Emptying the Waste Ink Tank on page 65. 

 Cleaning the Printing Pallet, Maintenance Tray, and Orifice Plate  
on page 66. 

 Performing Print Head Purge and Wipe on page 67. 

 Performing a Nozzle Test on page 68. 
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1.1 Renewing the Ink Supply 

Visually examine the level of ink in the ink bottles before beginning to 
print. Make sure that there is enough ink to print at least the first 
several jobs of the day.  

To renew the ink supply, perform the following two procedures: 

 Replacing an Ink Bottle on page 55. 

 Verifying that Secondary Ink Tanks are Full on page 60. 

1.1.1 Replacing an Ink Bottle 

When an ink bottle is less than 10% full, we recommend that you 
replace the bottle.  

 To replace an ink bottle:  

1. Open the service door on the printer's right side. 

a. Press the door latch button; the door latch handle pops out. 

b. Pull on the handle to open the service door. 

 
Figure 32: Replacing the Ink Bottle 

Male Quick Connector 

Female Quick Connector and 
Quick Release Ring 

 

Cap 

 

 
 
 
Bottle 
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2. On the (ink bottle) quick connector, pull down on the quick release 
ring; the female quick connector separates from the male quick 
connector. 

 
Figure 33: Ink Bottle 

3. Unscrew the cap from the used ink bottle and then discard the 
bottle. 

4. Remove the plastic cover cap from the new ink bottle. 

5. Screw the cap onto the new (full) ink bottle. 

 

NOTE: 

We recommend that you shake up the white ink bottles in storage, once a 
week but not less than 24 hours before their use.  

Do not shake the ink bottles immediately before replacement. 

 

6. Push the female connector up into the male connector until it snaps 
into place. 

7. Close the service door and depress the door latch button to lock the 
door. 

Female Quick Connector and quick 
release ring 

 

Cap 
 
 
 
 
Bottle 
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1.2 Activating the Printer 

 

NOTE: 

If the printer is already active (e.g. the beginning of a new shift), continue with 
Verifying that Secondary Ink Tanks are Full on page 60 . 

 

Activate the printer in the same manner, both when the printer has 
been briefly inactive and when it has been unused for a prolonged 
period.  

 To activate the printer: 

1. Turn on the computer and turn on the power to the printer. See 
Switching on the Main Power on page 58; the Scan and Cross Scan 
axes are initialized.   

 

WARNING! 

The activation process takes several moments to complete. Keep your hands 
clear of moving parts. 

 

NOTE: 

After initialization, the printer automatically performs Spit. 

 

2. View the LCD Maintenance panel. When activation is complete, 
"Ready" appears in the status field. 
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3. On the computer desktop, click the Breeze application icon; the 
Main Window appears. 

 
Figure 34: Main Window 

 

NOTE: 

The printer can be activated and maintained from the LCD screen without the 
use of QuickP software. 
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1.2.1 Switching on the Main Power  

The main power switch is located at the back left-side of the printer. 
Turn this power switch on to operate the system.  

 
Figure 35: Main Power Switch 

 To switch on the main power: 

1. Verify that the power cable is connected to the main power source. 

2. Close the hood, doors, side guards, and panels. 

3. Make sure that the emergency stop switch is released. 

4. Press the main power-switch so that the "I" symbol is in the 
depressed position. 

 

NOTE: 

To switch off the main power, press the power switch so that the "O" symbol is 
in the depressed position. 

 



60  Kornit Breeze User Guide 

Last printed: 1/11/2012 4:38:00 PM 

Last saved: 1/11/2012 4:38:00 PM 

1.2.2 Verifying that Secondary Ink Tanks are Full 

After initialization, the printer fills the Secondary Ink Tanks.  

 To verify that the secondary ink tanks are full: 

View the Secondary Ink Tank icons either in the LCD Maintenance 
Panel window or in the Main Window. 

 

 

 

 

Figure 36: Main Window Figure 37: LCD Maintenance Panel 

 When the Secondary Ink Tanks are full: 

 In the LCD Maintenance Panel, the icons appear as full inkpots. 

 In the Main Window, the icons appear as colored spheres. 

 When the Secondary Ink Tanks are not full: 

 In the LCD Maintenance Panel, the icons appear as empty 
inkpots. 

 In the Main Window, the icons contain Exclamation marks. See 
Figure 25 on page 41. 

 

NOTE: 

When the Secondary Ink Tanks are not full, see Manually Filling the Secondary 
Ink Tanks on page 213. 
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1.3 Refilling the Fixation Spray 

The Fixation Spray tank is located behind the left service door. Visually 
examine the level of fixation liquid in the tank.  

Make sure that there is sufficient fixation liquid for at least the first 
several jobs of the day. If the fixation liquid level drops below the 
minimum level, air can enter the system and cause problems with the 
fixation spray system. 

 
Figure 38: Fixation Spray Tank 
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NOTE: 

 

The Main Window displays the Spray icon, which indicates the following 
conditions. 

  There is sufficient spray in the Fixation Spray tank to perform several more 
prints. 

  There is insufficient spray in Fixation Spray tank to perform several more 
prints. 
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 To prepare the fixation liquid: 

 

NOTE: 

The fixation liquid is a mixture of tap water and the Kornit fixing agent. Prepare 
the mixture at a distance from the printer. 

  

Figure 39: Fixation Agent – 1 Gallon Figure 40: Fixation Agent – 5 Liters 

 

1. Verify that the Fixation Spray tank and the mixing container are 
clean and without any residue. 

2. Pour the entire contents of the Kornit Fixing Agent bottle into the 
mixing container.  

 
Figure 41: Mixing Container 

3. Add tap water at a ratio of 1 part Kornit Fixing Agent to 3 parts tap 
water. 

4. Shake the mixture well. 
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 To refill the Fixation Spray tank: 

1. Verify that the printer is not in the print process.  

2. Shake the mixture before filling the Fixation Spray tank. 

3. Open the left service door to access the Fixation Spray tank. 

 
Figure 42: Left Service Door Open 

4. Open the Fixation Spray tank cap and carefully fill the tank; make 
sure that you do not overfill, causing fixation liquid to spill out. 

5. Close the Fixation Spray tank cap and then close and lock the left 
service door. 
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1.4 Emptying the Waste Ink Tank 

The waste ink outlet is located at the back-right corner of the 
maintenance tray. The waste ink tube connects to the waste outlet and 
runs into the waste ink tank, located at place of your choosing below 
the level of the maintenance tray. 

Visually examine the level of waste ink in the tank before beginning the 
initial printing procedure.  

 
Figure 43: Waste Ink Tank 

When the waste ink tank is more than 3/4 full, empty it so that it does 
not overflow during the course of your day’s work. 

 

NOTE: 

 We recommend a maximum waste ink tank capacity of five liters. 

 Do not empty the waste ink tank while printing as this can result in waste 
ink spilling outside of the tank. 
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1.5 Cleaning the Printing Pallet, 

Maintenance Tray, and Orifice Plate  

We recommend that you clean the printer before beginning the first 
print job of the day.  

 To clean the printing pallet, maintenance tray, and orifice 

plate: 

1. From the Main Window, click Maintenance > Operator; the 
Operator window appears. 

 
Figure 44: Operator Window 

2. Click Capping; the maintenance tray rises up to the Capping 
position. 

3. Clean the printing pallet, magnetic frame, and the bellows 
protecting the printing pallet axis, using paper towels and alcohol. 

4. Clean lint and fibers from around the printing pallets and bellows, 
using towels and alcohol. 
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5. Click Down; the maintenance tray lowers to the Down position. 

 

 

Figure 45: Print Heads                                                                 Figure 46: Maintenance Tray 

6. Clean the maintenance tray frame (housing the rubber capping 
seal) and the wipers, using lint-free towels and wiping fluid. 

7. Clean the print head plate frames, using lint-free wipes and wiping 
fluid. 

8. Clean the print head orifice plates, only using new lint-free wipes 
and wiping fluid. 

 

IMPORTANT NOTE: 

Do not clean with cleaning agents, other than those described above. 

 

1.6 Performing Print Head Purge 

For instructions on performing Print Head Purge, see Performing Print 
Head Purge on page 205. 

1.7 Performing Print Head Purge and Wipe 

For instructions on performing Print Head Purge and Wipe, see 
Manually Performing Purge and Wipe on page 206.  

Maintenance Tray frame 
with rubber seal 

Print Head Orifice Plate 

Wipers 
 
 

Print Head plate frame 
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1.8 Performing a Nozzle Test  

We recommend that you perform a Nozzle Test  before beginning the 
first print job of the day or between shifts. 

When you perform a Nozzle Test, you produce a printout that enables 
you to see if there any problems with the nozzles. If there is a problem, 
you can perform activities to solve them. 

 To perform a Nozzle Test: 

1. Place a piece of printing paper for CMYK (transparency for white 
color) onto the printing pallet, aligned to the bottom-right corner of 
the printing pallet. 

 
Figure 47: Aligning Printing Paper/Transparency 

2. From the Main Window, click Maintenance > Operator; the 
Operator window appears. 

 

NOTE: 

You can also initiate a Nozzle Test from the LCD Maintenance panel. 

 

3. Click the Nozzle Test button; the Nozzle Test image is printed. 

 

WARNING! 

When you click the Nozzle Test button, the printing pallet immediately begins to 
move and the printer begins to print. 

 

 

Nozzle Test Paper 
 
Bottom-right corner 

Printing Pallet 
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4. Record the following information on the printed image sheet and 
store the sheet near the printer: 

 Date – Date of Nozzle Test. 

 Time – Time of Nozzle Test. 

 Name – Name of Operator performing the test. 

1.8.1 Interpreting the Nozzle Test 

 
Figure 48: Nozzle Test Image 

The Nozzle Test image is divided into two test groups:  

 CMYK Nozzle Test 

 White Nozzle Test 

 

NOTE: 

The nozzle test reflects the physical location of the print heads. 

The boundary lines, in Group Four, enable viewing problematic nozzles that are 
located on the edges of the print heads. 

 

White Nozzle Test 
 
           Group Four                          Group Three                Group Two       Group  
                                                                                                                      One 
 
 
 
 
 

 

 

CMYK Nozzle Test 
 
           Group Four                          Group Three                Group Two        Group 
                                                                                                                       One 
 

                                                                                                                                  

Boundary 
Lines 
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The Nozzle Tests are divided into four groups: 

 Group One – Displays a printed dash, in one row and for each 
color, from all 256 nozzles.  

 Group Two – Divides the Nozzle Test into two rows where the 
odd numbered nozzle printed dashes appear in the right row 
and the even numbered nozzle printed dashes appear in the left 
row.  

 Group Three – Divides the nozzles into three rows where the 
first nozzle printed dash appears in the first row, the second 
nozzle printed dash in the second row, the third nozzle printed 
dash in the third row, the fourth nozzle printed dash in the first 
row and so on. 

 Group Four – Divides the nozzles into four rows (following the 
same logic). 

 
NOTE: 

In Group One, it is easy to see where there are missing nozzles but it is difficult 
to determine the number of missing nozzles. In the other groups, it is easier to 
examine the problematic areas and to determine the number of missing 
nozzles. 

 

Carefully examine the printed image for the missing (possibly clogged) 
nozzles as signified by missing printed dashes. 

 
Figure 49: Missing and/or Defective Nozzles 

If a printed dash is not sharply defined or is crooked, perform several 
purges and clean the orifice plates with wiping fluid and lint-free wipes, 
until the nozzle test improves to a satisfactory status.  
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2 Closing the Printer after a Workday  

Before closing the printer, we recommend that you perform the 
following procedures, in the order that they appear: 

 

WARNING! 

Do not stand close to the printer during this process as the printing pallet and 
print head carriage move automatically. 

 

1. Clean the maintenance tray and orifice plate. See Cleaning the 
Printing Pallet, Maintenance Tray, and Orifice Plate on page 66. 

2. Clean the print heads and the print head orifice plate. 

3. Clean the printing pallets and bellows. 

4. From the LCD Maintenance panel, shut down the printer: 

a. Press F1; the following message appears in the LCD screen: 

"Do you really want to turn off the printer?" 

b. Using the Move Left button , select Yes. 

c. Press the Enter button  to confirm; the system 
automatically performs cleaning procedures, and then 
displays the following message on the LCD screen: 

"Safely turn off the printer." 

5. Turn off the power to the printer using the Main Power Switch 
located on the left side of the printer. 

6. Examine and, if necessary, renew the ink supply. See Renewing 
the Ink Supply on page 55. 

 
NOTE: 

 When the printer shuts off, the application is completely disabled. To 
reactivate the application, switch on the power to the printer. 

 For more on using the LCD Maintenance Panel, see Maintaining the 
Printer from the LCD Maintenance Panel on page 170. 
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3 Breeze Daily Workflow Map 

 
Figure 50: Daily Workflow Map  
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Chapter 3: 

Performing Printing Procedures 

Performing Printing Procedures explains all the procedures involved in 
the actual printing process. 

Performing Printing Procedures includes: 

 Placing a Garment onto a Printing Pallet on page 74. 

 Starting the Printer on page 76. 

 Unloading a Garment from the Printing Pallet on page 78. 

 
Figure 51: Printing Workflow 
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1 Placing a Garment onto a Printing 
Pallet 

After each spraying or printing process, or at the start of the work day, 
the system automatically moves the printing pallets towards you, to the 
loading position. In the loading position, you can place the garment 
onto the printing pallet.  

 To place a garment onto the printing pallet:  

1. Slide the garment onto the printing pallet and position as follows: 

 Print side facing upwards. 

 The top of the garment (e.g. the t-shirt neck opening) towards 
you.  

 
Figure 52: Placing the Garment 

 

NOTE: 

The printing will appear upside down to you. 

 

2. Fold any excess garment material underneath the printing pallet. 
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Figure 53: Folding Under Excess Garment  

3. On the printing pallet, gently smooth out any visible garment 
wrinkles. Do not stretch the material. 

 
Figure 54: Smoothing Wrinkles  

4. Carefully set the magnetic pallet frame onto the printing pallet.  

 

CAUTION! 

Verify that the frame is securely in place before continuing. 
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2 Starting the Printer 

To start printing, choose from the following options: 

 Click the Print button in the Main Window. 

 Press the (green) printer Start button. 

2.1 Start Printing by Clicking the Software 

Interface Print Button  

1. In the Main Window, click the Print button; the printer begins to 
print the first job appearing in the job queue and runs until the 
printed image is completed. 

 
Figure 55: Main Window 

2. For each subsequent copy of the print job, unload the printed 

garment, load the new garment, and then press the interface Print 

button or the printer Start button. 

 

NOTE:  

When the last copy of the print job has been printed, the job is removed from 
the queue and the next job moves to the top of the printing queue. 
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2.2 Start Printing by Pressing the Printer 

Start Button 

1. On the printer front panel, press the green Start button (located to 
the right of the printing pallet); the printer begins to print the first job 
appearing in the job queue and runs until the printed image is 
completed. 

 
Figure 56: Start Button 

2. For each subsequent print job copy, unload the printed garment, 

load the new garment, and then press the application Print button 

or the printer Start button. 

 

NOTE:  

When the last copy of the print job has been printed, the job is removed from 
the queue and the next job moves to the top of the printing queue. 
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3 Unloading a Garment from the 
Printing Pallet 

After each spraying or printing process, the system automatically 
brings the printing pallet forward to the loading position. From this 
position, you can remove the current garment and load the next one.  

 To unload a garment from the printing pallet: 

1. Lift off the magnetic pallet frame. 

2. Hold the garment at the top of each side and gently lift it off the 
printing pallet, taking care not to wrinkle it. 

3. Letting it hang down straight, take the garment to the dryer.  

4. Gently lay the garment on the dryer, making sure not to wrinkle it. 
See Dryer on page 199. 
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Chapter 4: 

Managing Job Setups 

From the Setup Editor, you can perform the following: 

 Creating New Setup Files on page 80. 

 Modifying Existing Setup Files on page 82. 

 Deleting Existing Setup Files on page 84. 

 Importing Setup Files on page 85. 

 Exporting Setup Files on page 87. 

 

NOTE:  

When creating and modifying setups files, we recommend that the setup name 
provide an indication of the specific parameters that make up the setup file.  

For example: 

 The brand of the garment. 

 Specific elements in the setup (e.g. white percentage, spray amount, 
resolution, full frame, stroke etc.) 
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1 Creating New Setup Files 

Use the Setup Editor to create and save new Setup files. 

 To create a new Setup file: 

1. From the Main Window, click Tools > Setup Editor; the Setup 
Editor appears. 

 
Figure 57: Setup Editor 

2. From the Setup Name dropdown box, select a setup that is similar 
to the setup that you want to create; the selected setup's 
parameters appear in the various parameter fields. 

3. Enter new parameters, where required.  
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4. Click Save; the Save Setup window appears. 

  
Figure 58: Save Setup Window 

5. Enter an appropriate and unique name into the Setup Name field 

and click OK; an Information window informs that the setup was 
saved successfully.   

  
Figure 59: Setup Information Window 
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2 Modifying Existing Setup Files 

Access the Setup files that are stored in your Setup database and then 
redefine the setup parameters according to your business needs. 

 To modify existing Setup files:  

1. From the Main Window, click Tools > Setup Editor; the Setup 
Editor appears. 

  
 Figure 60: Setup Editor 

2. From the Setup Name dropdown box, select the setup that you 
want to modify. 

3. Modify the necessary parameters.  
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4. Click Save; the Save Setup window appears. 

   
Figure 61: Save Setup Window  

5. From the Setup Name dropdown box, select the name of the setup 

that you are modifying and click OK; the Save Setup warning that 
the Setup already exists (in the Setup database)..   

  
Figure 62: Save Setup Warning 

6. Click Yes to save the modified parameters; an Information window 
informs that the setup was saved successfully.   

 
Figure 63: Setup Information Window 
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3 Deleting Existing Setup Files 

Use the Setup Editor to delete setup files from your Setup database. 

 To delete setup files: 

1. From the Main Window, click Tools > Setup Editor; the Setup 
Editor appears. 

 
Figure 64: Setup Editor 

2. From the Setup Name dropdown box, select the name of the setup 
file to delete. 

3. Click the Delete control button; the setup file is deleted from the 
Setup database. 
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4 Importing Setup Files  

You can import setup files, from an external source, to your Setup 
database. 

 To import a setup file to your Setup database: 

1. From the Main Window, click Tools > Setup Editor; the Setup 
Editor appears. 

 
Figure 65: Setup Editor 
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2. Click the Import control button; the Open window appears. 

 
Figure 66: Setup Editor 

3. Browse to the folder containing the setup file to be imported. 

4. Enter an appropriate file name and click Open: 

 If the file already exists in the Setup database, a warning 
appears: 

 Click Yes to overwrite. 

 Click No to end the Import procedure. 

 If the file does not already exist, the file is saved in the Setup 
Database folder. 
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5 Exporting Setup Files  

You can export setup files, to an external folder, from your Setup 
database. 

 To export a setup file from your Setup database: 

1. From the Main Window, click Tools > Setup Editor; the Setup 
Editor appears. 

 
Figure 67: Setup Editor 

2. From the Setup Name dropdown box, select a setup name file. 



88  Kornit Breeze User Guide 

Last printed: 1/11/2012 4:38:00 PM 

Last saved: 1/11/2012 4:38:00 PM 

3. Click Export; the Save As window appears. 

 
Figure 68: Save Setups Window 

4. From the Save In dropdown box, browse to a suitable folder 
location. 

5. Enter an appropriate Setup file name. 

6. Click Save. 
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Chapter 5 

Managing the Job Queue 

The job queue  lists all of the job files that have been uploaded to the 
system and displays the processing status and details of each job. 

 

NOTE: 

The system processes the first job in the queue. 
 

Managing the Job Queue includes: 

 Verifying and Preparing Your Graphic Image Files  on page 90. 

 Uploading, Creating, Defining, and Deleting Jobs on page 94. 

 Managing File Lists on page 108. 

 Organizing the Job Queue on page 109. 
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1 Verifying and Preparing Your 
Graphic Image Files  

Before beginning the printing process, verify that your graphic image 
files are suitable for printing, according to: 

 Resolution.  

 Garment Color. 

1.1 Verifying Graphic Image File 

Resolution 

Graphic file resolution requirements are as follows: 

 Input graphic files – When the image size is the same as the 
required print size, the minimum resolution should be 150dpi. 

 Small files – The minimum resolution should be 150dpi. 

 Large files – The optimum resolution is 150dpi. 

1.2 Preparing your Graphic Image Files 

according to Garment Color 

Before loading an image, determine whether you are printing on a dark 
or light garment: 

 When printing on a light garment, begin with step ‎6.   

 When printing on a dark garment, you must first verify that you are 
printing a transparent image file. If you are not printing a 
transparent image file, you can convert your image file to a 
transparent image file as described in "To convert a regular image 
file to a transparent image file using Photoshop" on page 91. 
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NOTE: 

The following procedure can be performed using any graphic application 
program that supports creating transparent layers and saving the image in 
PNG, PSD, and TIFF formats. 

Refer to the specific graphic application help service for correct instruction 
in creating transparent images. 

 

 To convert a regular image file to a transparent image file 

using Photoshop: 

1. From the Photoshop menu, click File > Open and browse to your 
image file; the file image appears in the Photoshop work area. 

 
Figure 69: File Image 
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2. In the Photoshop toolbar (on the left), click the Magic Eraser icon; 
the Tolerance field and Contiguous check box appears in the Magic 
Eraser toolbar. 

 
Figure 70: Selecting Magic Eraser 

3. Select the Contiguous checkbox and enter an appropriate 

Tolerance level. 

4. Click the mouse anywhere in the area that should be transparent 
(to select several areas, hold down the Shift key while clicking the 
additional areas); the selected areas become transparent. 

 
Figure 71: Selecting Transparent Layer 
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5. Save the file, under a new name, with one of the formats that can 
support transparent layers: 

 PNG 

 PSD 

 TIFF (when selecting TIFF, you must select the Save 

Transparency option in the TIFF Options window. 

 
Figure 72: Selecting Save Transparent Option 

6. Check for layers: 

 If the file is comprised of multiple transparent layers, from the 

Photoshop menu, select Layer > Merge Visible. 

 If visible layers still exist, delete them from the Layers window.  
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2 Uploading, Creating, Defining, and 
Deleting Jobs 

 
Figure 73: Main Window 

To create a new job, perform the following activities: 

 Uploading a Job File to the Job Queue on page 95. 

 Setting Up the Job File for Printing on page 103. 

 Deleting Job Files from the Job Queue page 107 
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2.1 Uploading a Job File to the Job Queue 
The job file must first be uploaded to the job queue.  

There are four methods for uploading a job file to the job queue: 

 To upload a job file to the job queue (drag and drop), see page 96. 

 To upload a job file to the job queue (standard upload), see page 
97. 

 To crop and upload an image (crop from the Open window), see 
page 99. 

 To upload and crop an image (crop from the File Details window) 
on page 100. 

 

NOTE: 

When the uploaded image is larger than the printing pallet, the printer issues a 
warning to that effect. 
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 To upload a job file to the job queue (drag and drop): 

1. Select an appropriate job file and drag/drop the file onto the 
Preview pane; the image appears in the Preview pane. 

 
Figure 74: File Details Window 

2. Modify the job file parameters and click OK; the image appears in 
the Preview pane and the job file name appears in the job queue. 

 
Figure 75: Main Window 
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 To upload a job file to the job queue (standard upload):  

1. From the Main Window, click New File; the Open window appears. 

 
Figure 76: Open Image File Window 

2. Select an image file; when the Preview checkbox has been 
selected, the image appears in the Preview pane on the right side 
of the window. 

 

NOTES: 

 We recommend using the following image formats: Tiff, PNG, JPG, and 
PSD. 

 When an image file is uploaded to the system, a .KSF file is automatically 
generated adjacent to the uploaded image file; the .KSF file is not an 
image file and only contains job ticket and job format information. 
Therefore, do not upload a .KSF file. 

 To delete the automatically generated .KSF file, select the Delete .Ksf file 
checkbox. 

 If a .KSF file has been generated for an image file (i.e. the image file has 
previously been uploaded to the system), when uploading the image file 
again, the file enters directly into the job queue. 

 To upload an image file that has previously been uploaded to the system 
but with new setup parameters, first delete the .KSF file. 

 

3. Click Open; the image file appears in the File Details window and 
the image appears centered in the Preview pane. 
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NOTE: 

The position of the image in the Preview pane reflects the position of the 
printed image on the printing pallet. 

 

 
Figure 77: File Details Window: Job Ticket Parameters Panel 

4. Modify the job file parameters and click OK; the image appears in 
the Preview pane and the job file name appears in the job queue. 

 
Figure 78: Main Window 
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 To crop and upload an image (crop from the Open window): 

1. From the Main Window, click New File; the Open window appears. 

2. Select a job file; when the Preview checkbox has been selected, 
the image appears in the Preview pane. 

3. Place the cursor into the Preview pane; the cursor changes to a 
pointer. 

4. Holding down the left mouse button, mark out the section of the 
image for cropping. 

 
Figure 79: Open Image File Window 

5. Click the Open button; the cropped image appears in the File 
Details window. 

 
Figure 80: Main Window 

Crop Mark 
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6. Click OK to accept the cropped image; the image appears in the 
Preview pane and the image name appears in the job queue. 

7. Where necessary, adjust the size of the image. 

 To upload and crop an image (crop from the File Details 

window): 

1. From the Main Window, click New File; the Open window appears. 

2. Select a job file; when the Preview checkbox has been selected, 
the image appears in the Preview pane. 

3. Click Open; the image appears in the Preview pane. 

4. Right-click the image; the Crop context menu appears. 

 
Figure 81: Job Set Preview Pane 

5. Click Enter Crop Mode; the cursor changes to an  crop tool. 

6. Using the crop tool, mark out the section of the image for cropping. 



 Chapter 5: Managing the Job Queue  101 

Last printed: 1/11/2012 4:38:00 PM 

Last saved: 1/11/2012 4:38:00 PM 

 
Figure 82: Open Image File Window 

7. Right-click the image again; the Crop context window appears. 

 

Crop Mark 
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8. Click Set Crop to perform the crop. 

 

NOTE: 

To cancel the crop procedure, click Exit Crop Mode. 

 

 
Figure 83: File Details Window 

9. Define the file details and then click OK; the cropped image 
appears in the Preview pane and the image name appears in the 
job queue. 

10. Where necessary, adjust the size of the image. 



 Chapter 5: Managing the Job Queue  103 

Last printed: 1/11/2012 4:38:00 PM 

Last saved: 1/11/2012 4:38:00 PM 

2.2 Setting Up the Job File for Printing 

After uploading the job file, select an appropriate job setup and define 
the number of copies to be printed.  

Perform the following procedures: 

 To select an appropriate job setup on page 104. 

 To set up the job file for printing on page 105. 

 To modify job file parameters and then set up the job file for 
printing on page 105. 



104  Kornit Breeze User Guide 

Last printed: 1/11/2012 4:38:00 PM 

Last saved: 1/11/2012 4:38:00 PM 

 To select an appropriate job setup: 

Use the chart below to select a job setup (provided by Kornit) according 
to the input file type. 

 

Figure 84: Input File Type Window 

Input File Type File Information Recommended Job Setup 

 6 chan, CMYK 

 TIFF or PSD 

CMYK, White, and Highlight 
channels for printing on 
black/dark garments 

BlackT Manual 

 5 chan, CMYK 

 TIFF, PSD, or 
PNG 

CMYK channel with transparent 
layer, mainly for printing on black 
or dark garments. 

BlackT Default 

 4 chan, CMYK 

 JPG, TIFF, 
PSD, or PNG 

CMYK channel, mainly for 
printing on white or light-colored 
garments. 

WhiteT Manual 

 4 chan, RGB 

 TIFF, PSD, or 
PNG 

RGB channel with transparent 
layer, mainly for printing on black 
or dark garments. 

BlackT Default 

 3 chan, RGB 

 JPG, TIFF, 
PSD, or PNG 

RGB channel, mainly for printing 
on white/light-colored garments. 

White Default 
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 To set up the job file for printing: 

1. From the Setup Name dropdown box, select an appropriate job 
setup; all of the file detail properties appear. 

2. In the Copies box, enter the number of copies to be printed. 

3. Click OK; the job files enters the job queue. 

 To modify job file parameters and then set up the job file for 

printing: 

1. Select a setup name from the Setup Name dropdown box. The job 
setup will serve as the basis of the modified setup.  

2. Enter the number of copies of this file to be printed. 

3. If required: 

a. Reposition the image along the Scan axis, using one of the 
following options: 

 Select the X Center checkbox to center the image on the 
Scan axis. 

 Clear the X Center checkbox: 

 Enter an appropriate value; the image moves along the 
Scan axis according to the entered value. 

 Drag and drop the image to an appropriate location on 
the Scan axis. 

b. Reposition the image along the Cross Scan axis, using one 
of the following options: 

 Select the Y Center checkbox to center the image on the 
Cross Scan axis. 

 Clear the Y Center checkbox: 

 Enter an appropriate value; the image moves along the 
Cross Scan axis according to the entered value. 

 Drag and drop the image to an appropriate location on 
the Cross Scan axis. 
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c. Adjust the width and height of the image: 

 Select Keep Ratio to maintain the width/height ratio when 
either the width or height parameter is changed. 

d. Select the Rotate 90 checkbox to rotate the image 90 
degrees. 

e. Select the Rotate 180 checkbox to rotate the image 180 
degrees. 

f. Select the Mirror checkbox to create a mirror image of the 
original image. 

g. Reset the Spray Amount. For setting the Spray Amount, see 
Managing the Media Database on page 120. 

 Select the Spray and/or Wipe checkboxes to spray and/or 
wipe the media. Wipe flattens the shirt fibers, after applying 
the fixation spray, to provide a higher quality print result. 

h. Select a new White Print Mode and readjust the white color. 
See Defining White and Highlight Layers on page 33. 

4. To preview the changes to the image made by the modified file 

detail parameters, click Show Preview. 

5. To individually preview the color layers, select the following check 
boxes: 

 CMYK – Only the CMYK layer appears in the Preview. 

 White – Only the white layer appears in the Preview. 

 Highlight – Only the white highlight appears in the Preview. 

6. Click OK to save the modified setup parameters and upload the file 
to the job queue. 

 

NOTE: 

Parameters modified in the File Details window will be applied only to the 
specific job. Use the Setup Editor to create new job setup files. See Setup 
Editor on page 26 . 
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2.3 Deleting Job Files from the Job Queue 

You can delete any job file or queue from the job queue (even after 
pressing the Emergency Stop button during the printing procedure).  

 To delete a single job file from the job queue:  

1. Select the target job file in the queue. 

2. Click Delete File; the job file is removed. 

 To delete all of the files from the job queue: 

Click Delete Queue; all of the files in the job queue are deleted. 
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3 Managing File Lists 

You can save a list of jobs that you want to print, according to a 
specific order. This list of jobs can be saved as a .qu file and later 
loaded for printing.  

 

NOTE:  

The jobs in the list will include their job parameter settings, as well as their 
setups (advanced parameter settings). 

 

 To save a file list: 

In the job queue, click the Save Queue button; all of job files in the 
queue, together with their parameters, are saved in a QU file in a folder 
of your choice.  

 To load a file list to the job queue:  

1. Click Load Queue and browse to the folder containing the queue 
file. 

2. Select the .qu file and click Open; the file appears in the job queue. 

 

NOTE: 

This file list remains in the job queue until you delete it or load a different job 
list. 

The file list only saves each file’s path. To reload the list, you must store all of 
the lists in the same location.  

When working on a network, make sure that your network is connected. 
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4 Organizing the Job Queue 
The system prints the jobs according to the order, from top to bottom, 
that the job files appear in the job queue. You can define the position of 
each job within the job queue:  

 To move a job up or down in the job queue: 

1. When there are at least two job files in the job queue, select the 
appropriate file. 

2. Drag and drop the file into the appropriate row. 

 To move a job file one row up or down in the job queue: 

1. When there are at least two job files in the job queue, right-click the 
job file that you want to move one row in the queue; the Move 
context window opens. 

 

2. Click Move Up to move the job file up one row in the job queue. 

3. Click Move Down to move the job file down one row in the job 
queue.  

 To move a job file to the top of the job queue: 

1. When there are at least three job files in the job queue, right-click 
the job file that you want to move to the top of the job queue; the 
Move context window opens. 

 

2. Click Move to Top; the job file moves to the top of the job queue. 

 To move a job file to the bottom of the job queue: 

1. When there are at least three job files in the job queue, right-click 
the job file that you want to move to the bottom of the job queue; 
the Move context window opens. 

 

2. Click Move to Bottom; the job file moves to the bottom of the job 
queue. 
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Chapter 6: 

Configuring Advanced System 

Parameters 

Configuring the System describes how you can change the system 
parameters according to your requirements.  

Configuring the System includes the following sections: 

 Activating the Technicians Mode on page 112. 

 Manually Setting the Printing Pallet Height on page 113. 

 Configuring Print Head Functionality on page 115. 

 Configuring Media Database Operation Parameters on page 118. 

 Configuring the Pallet Type on page 123. 

 Handling Parameters on page 125. 

 Backing Up and Restoring Parameters on page 126. 

 Configuring the Message Display on page 130. 

 Downloading Software on page 131. 

 Uploading and Downloading Axis Speed Configurations (S-Curve 
Files Handling) on page 133. 

 Updating the System Password on page 137. 



112  Kornit Breeze User Guide 

Last printed: 1/11/2012 4:38:00 PM 

Last saved: 1/11/2012 4:38:00 PM 

1 Activating the Technicians Mode 

To test and configure some system elements, you must first change 
the system mode from Operator to Technician.  

 

NOTE: 

 System elements that require Technician privileges (Technician Mode) 
appear as "disabled" in the Operator mode. 

 The Technician mode is intended for qualified Kornit engineers. 

 

 To activate the Technician mode: 

1. From the Main Window, click Tools > Technician; the Password 
Update window appears. 

 
Figure 85: Password Update Window 

2. Enter your password and click OK. 

3. From the Main Window, click Maintenance > Technician; the 
system changes to the Technician mode.  

 To reactivate the Operator Mode: 

From the Main Window, click Tools > Operator; the system returns to 
the Operator Mode.  
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2 Manually Setting the Printing Pallet 
Height  
Set the distance between the print heads and the media so as to 
prevent contact, thereby preventing damage to the garment and the 
print heads during the printing procedure. 

 
Figure 86: Height Adjustment System  

 

NOTE: 

 To manually set the printing pallet height before performing a wizard, the 
media refers to a transparency. See Registering the Print Heads: Print 
Registration Wizard on page 140 and Calibrating the Print Head Position: 
Print Position Wizard on page 151.  

 To manually set the print height for a new media, the media refers to a test 
garment.  

 

 To manually set the printing pallet height: 

1. Place the media onto the printing pallet.  

2. Using the LCD Maintenance Panel direction arrows, move the print 
head carriage to a position above the printing pallet travel path. See 
Maintaining the Printer from the LCD Maintenance Panel  
on page 170. 

3. Using the LCD Maintenance Panel direction arrows, slowly move 
the printing pallet to a position beneath the print head carriage. 

Pallet Bases 

 
 

 
 

Height 
Adjustment 
Wheel 

Garment 
Guard 
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NOTE: 

Watch the space between the print heads and the garment. If you see that the 
garment and the print heads might come into contact, turn the Pallet Height 
adjustment wheel to lower the printing pallet.  

 

4. Using the Pallet Height adjustment wheel, raise or lower the 
printing pallet height so that the gap between the garment and the 
print heads is 2 mm. 

5. Click the Home and Load Position buttons to manually move the 
printing pallet backwards and forwards. 
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3 Configuring Print Head 
Functionality  

From the Technician/Head Properties window, you can configure print 
head functionality, adjust the negative pressure level, and perform 
specific system actions.  

 

NOTE: 

To access the Technician window, you must be in the Technician mode. See 
Activating the Technicians Mode on page 112. 

 

 To access the Technician/Head Properties window: 

1. From the Main Window, click Maintenance > Technician; the 
Technician window appears. 

2. Click Head Properties; the Technician/Head Properties window 
appears. 

 
Figure 87: Technician/Heads Properties Window 
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From the Technician/Head Properties window, you can: 

 View:  

 The ink level of each ink tank (in the Ink Level column). 

 The actual temperature of each print head (in the Temp°C 
column). 

 The actual Negative Pressure Level (displayed to the left of the 
Negative Pressure Level field). 

 Perform: 

 Ink Reset – Reset the ink level indicator and activate the pump 
when the ink level is low. In case of low ink levels in the 
secondary ink tanks, see Manually Filling the Secondary Ink 
Tanks on page 213.  

 Spray Pump – Manually activate the spray pump for testing 
purposes.  

 Spray Wiper – Manually activate the spray wiper for testing 
purposes (without moving the printing pallet). 

 Configure: 

 Set Temp (ºC) – The temperature of each individual print head.  

 Pulse Width (S) – The pulse width of each individual print 
head.  

 Bias (V) – The pulse amplitude of each individual print head.  

 The Negative Pressure Level (vacuum) 
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 To configure Bias, Pulse Width, and Set Temp: 

In the Technician/Head Properties window, click the Bias, Pulse Width, 
and Set Temp fields and perform the necessary changes. 

 Click Set to apply all changes made to the print head parameters. 
These changes are immediately applied but not saved in a 
permanent memory file; when the printer is powered off without 
saving the changes, the changes are lost.  

 Click Get to load the parameters from the temporary memory file 
(i.e. loads files saved when clicking Set).  

 Click Default to reload factory default settings. 

 To configure the Negative Pressure level: 

In the Technician/Head Properties window, click the Negative Pressure 
Level field and perform the necessary changes. 

 Click Set to apply the changes that you made. These changes are 
immediately applied but not saved in a permanent memory file; 
when the printer is powered off without saving the changes, the 
changes are lost.  

 Click Get to reload Negative Pressure Level parameters from the 
system's memory (i.e. after making value changes, but not clicking 
Set, you can return to the original set value).  
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4 Configuring Media Database 
Operation Parameters 

 
Figure 88: Media Data Base 

Jobs can be printed on a wide range of media types, which can be 
stored in the Media database. Your system has been installed with a 
number of pre-defined media definitions, which you can use, or you can 
create new definitions, as required.  
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Media database settings include the following parameters:  

 Media Name – The name of the media type.  

 Dark Media – Indicates whether the media is a dark color. When 
selecting the Dark Media option, the system enables the "White 
Print Mode" options in the File Detail Parameters Panel (see White 
Print and Highlight Mode on page 32). 

 Spray Amount –The amount of fixation spray that is suited to this 
material. The spray amount is: 

 Entered as a percentage. 

 Chosen according to the garment type and garment color 
(dark/light). Generally, a more absorbent garment requires a 
greater amount of spray. Additionally, a dark garment that 
requires a white layer underneath the CMYK layer requires a 
greater amount of spray. 

 Look Up Table – Limited number of factory-produced settings that 
include color calibration (color linearization tables) and print 
resolution. When creating a new media, select a Look Up Table 
setting according to: 

 Garment Color (e.g. black, dark, light). 

 Print Resolution.  

 

NOTE: 

In general, dark media requires a higher resolution than light media. 

 

 Author – The name of the operator who defined the media type. 
The author of a default media, which cannot be deleted, is defined 
as Factory. 
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4.1 Managing the Media Database 

From the Media Data Base window, you can perform the following 
tasks: 

 Import medias to the Media database. 

 Configure a specific media in the Media database. 

 Add new medias to the Media database. 

 Delete medias from the Media database. 

 Export medias from the Media database to another folder. 

 To import a media database: 

1. From the Main Window, click Tools > Media Data Base; the Media 
Data Base window appears.  

 
Figure 89: Media Data Base Window 

2. Click the Browse button  ; the Open window appears. 

3. Browse to the media database file and click Open; the media 
database appears in the window. 
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 To configure the settings of a specific media: 

 To change a media name, click the Media Name field and overtype 
with a new name.  

 When using dark-colored garments, select the Dark Media 
checkbox.  

 To increase or decrease the amount of fixation spray on the 

garment, click the Spray Amount field and overtype the Spray 
Amount percentage.   

 Click the Look Up Table field and select a suitable setting.  

 Click the Author name field and overtype with a new name.   

 

NOTE: 

The author name of a media created by Kornit cannot be changed. 

 

 To add a media to the database: 

1. In the New Media Name field, enter a new media name.  

2. Click Add; the new name appears in the Media Name list. 

3. Update the new Media with the new required parameters 

 Dark Media. 

 Spray Amount (%). 

 Look Up Table. 

 Author. 

4. Click Save. 
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 To delete a media from the Media Database: 

1. Select the target media name; the entire row is selected.  

2. Click Delete; the Delete Confirmation dialog box appears. 

3. Click Yes; the row is deleted. 

4. Click Save. 

 To export a media to an external folder: 

1. Select the target media name; the entire row is selected.  

2. Click Export; the Select Export Folder dialog box appears. 

 
Figure 90: Browse to Export Folder Window 

3. Browse to the target folder and click OK; the Successful Export 
dialog box appears. 

4. Click OK. 
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5 Configuring the Pallet Type 

The system supports the following pallet types:  

 Normal (Standard) Pallet.  

 Children's Pallet. 

For more on pallet types, see Pallet Types on page 197. 

 To configure the pallet type: 

1. From the Main Window, click Tools > Pallet Types; the Pallet 
Types window appears.  

 
 Figure 91: Pallet Types Window 

2. Open the Pallet Selection dropdown menu and select the pallet 
name, from the Printing Pallet database, that reflects the actual 
printing pallet installed on the machine. 

3. Click Set to save the selection. 
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 To add a pallet type to the pallet database: 

1. Click the Import Pallet browse button; the Open window appears. 

2. Browse to the pallet type that you want to include in the file and 

click Open; the pallet type appears in the Import Pallet field. 

3. Click Import; the pallet type appears in the pallet database. 

 To remove a pallet type from the pallet database: 

1. Open the Pallet Selection dropdown menu and select the printing 
pallet that you want to remove from the database. 

2. Click Delete; the pallet type is removed from the pallet database. 

 

NOTE: 

You cannot delete the Normal (Standard) pallet. 
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6 Handling Parameters 

 

NOTE: 

Only Kornit technicians are authorized to perform changes to system 
parameters using the Parameters Handling window.  

 

 
Figure 92: Parameter Handling Window 

The Parameter Handling window lists all system parameters and 
displays all of the system parameter elements.  

The Parameter Handling window includes the following controls: 

 Filter – Enables focusing on specific parameters.  

 Update – Temporarily saves changes to the system parameters. 
These changes are lost when system power is turned off. 

 Save – Permanently saves changes to the system parameters. 

 Browse – Appears when you click a parameter that defines a path 
and enables you to define the parameter path. 
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7 Backing Up and Restoring 
Parameters 

 
Figure 93: Store/Restore Parameters 

From the Store/Restore Parameters window, you can  

 Back up system parameters in a separate folder. 

 Back up current log files in a separate folder. 

 Retrieve all of the backed up system parameters to the system. 

 Retrieve specific backed up system parameters to the system. 
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 To back up system parameters in a separate file folder: 

1. Click the Store Parameters Browse button; the Save As window 
appears. 

2. Browse to the parameters backup folder (Kornit 
Digital\Breeze921\Common\Working\Stored) and enter a file name; 
the parameters backup file path appears in the Store Parameters 
path field. 

3. Click Store; the system stores all of the parameters in a zip file and 
places the file in the parameters backup folder. 

 To back up current log files in a separate folder: 

1. Click the Store Current Log Files Browse button; the Save As 
window appears. 

2. Browse to the current log files backup folder (Kornit 
Digital\Breeze921\Common\Working\Stored) and enter a file name; 
the current log files backup file path appears in the Store Current 
Log Files path field. 

3. Click Save; the system stores all of the parameters in a zip file and 
places the file in the current log files backup folder. 

 To retrieve and store the backed up system parameters to 

the system: 

1. Click the Restore Parameters Browse button; the Open window 
appears. 

2. Browse to the parameters backup folder (Kornit 
Digital\Breeze921\Common\Working\Stored) and select the 
parameters zip file. 

3. Click Open; the file path appears in the Store Parameters path 
field. 
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4. Select any or all of the storage folders: 

 Tif Registration – Stores all of the registration and step 
(calibration) files. 

 Machine Configuration – Stores all of the machine parameter 
files. 

 Setup Files (kst) – Stores all of the setup files created in the 
system (C:\Kornit Digital\Breeze921\Common\Setups). 

 Media DB Files (lut, xml) – Stores all of the media data and all 
of the Lookup Table files 
(C:\Kornit Digital\Breeze921\Common\MediaDB). 

 Photoshop Action – Stores all of the Photoshop Action files 
(C:\Kornit Digital\Breeze921\Common\Photoshop Actions). 

5. Click Restore; the selected folder files are restored to the system. 

 To restore a specific parameter to the system: 

1. In the Restore Specific Parameters panel, click the browse 

button ; the Open window appears. 

2. Browse to the parameters backup folder (Kornit 
Digital\Breeze921\Common\Working\Stored) and select the specific 
file (.ENC or .XML) to restore; the file path appears in the Restore 
Specific Parameters path field. 

3. Click Restore; the selected file is restored to the system. 

4. Repeat all steps to restore additional parameters. 
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 To retrieve a specific backed up system parameter (stored in 

an .xml file) to the system: 

An .xml file, containing the specific system parameter, is sent to you 
from Kornit. Store this file on your server. 

1. Click the Browse button to browse to the .xml file containing the 
specific system parameter; the backup file path appears in the 
Store Parameters path field: 
Kornit Digital\Breeze921\Common\Working\Stored\XXX. 

2. Click Restore; the parameter is restored to the system. 
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8 Configuring the Message Display 
From the Main/Message Display, the system informs you of the 
following:  

 The current system status. 

 Procedures being performed. 

 System problems. 

 
Figure 94: Configuring the Message Display 

You can: 

 Hide or display the messages. 

 Add or remove scroll bars. 

 Permanently delete the messages from the display box. 

 To hide or display the messages: 

From the Main Window, click Tools > Message Display; depending on 
the current Hide/Display message status, either Hide or Show appears. 

 Click Hide to hide the messages. 

 Click Show to display the message 

 To add or remove the ability to scroll through the display 

box:   

From the Main Window, click Tools > Message Display; depending on 
the present Scroll/No Scroll message status, either Scrollable or 
Disable Scroll appears. 

 Click Scrollable to display the scrollbar, which enables you to scroll 
to the messages. 

 Click Disable Scroll to remove the scrollbar. 

 To permanently delete the messages from the display box: 

1. From the Main Window, click Tools > Message Display. 

2. Click Clear; the messages are permanently deleted. 



 Chapter 6: Configuring Advanced System Parameters  131 

Last printed: 1/11/2012 4:38:00 PM 

Last saved: 1/11/2012 4:38:00 PM 

9 Downloading Software 

When you have Technician privileges, you can download updates for 
the following electronic card software:  

 Main Board. 

 Spectra Board. 

 NP Board. 

 LCD Board. 

 RF Board. 

With Technician privileges, you can also download the software for any 
of the above electronic cards, in the case of card replacement. 

 To download electronic card software and software updates 

into your system: 

1. When you receive a software or software update file, save the file 
to your PC. 

2. From the Main Window, click Tools > Hardware Downloads > 

Firmware; the Firmware window appears. 

 
Figure 95: Firmware Window 

3. Click the Browse button ; the Select Firmware File window 
appears. 

4. Browse to the software/software update file: 
Breeze921\Common\Bin\Firmware\Release15.5 (or higher) and 
select the first of the two files. 

5. Click Open; the file path appears in the Firmware Update window. 
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6. Click Download; the file is downloaded to the system and the 
Firmware Update Completed Successfully window appears. 

7. From the Firmware window, browse to the software or software 
update file: 
Breeze921\Common\Bin\Firmware\Release15.5 and select the 
second of the two files. 

8. Click Open; the file path appears in the Firmware Update window. 

9. Click Download; the file is downloaded to the system and the 
Firmware Update Completed Successfully window appears. 

10. Perform Uploading and Downloading Axis Speed Configurations (S-
Curve Files Handling). See page 133. 

11. Turn off the printer and then turn on the printer again (to operate 
using the new update). 
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10 Uploading and Downloading Axis 
Speed Configurations (S-Curve 
Files Handling) 

 

NOTES: 

To upload and download axis speed configurations, you must first activate the 
Technicians Mode. 

 

Axis speeds have been pre-determined and configured in your system 
by Kornit. Using the S-Curve Files Handling window, with technician 
privileges, you can:  

 Download (import) new speed configurations (that you can receive 
from Kornit). 

 Upload system speed configurations to a folder for export. 

 To open the S-Curve Files Handling window: 

From the Main Window, click Tools > S-Curve Handling; the  
S-Curve Files Handling window appears.  

 
Figure 96: Configuring S-Curve Files Handling 
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NOTE: 

1. Browse to the file folder in which the new configurations are saved: 
Breeze921\Common\Bin\Curves. 

2. Write down the Axis Name and the Speed Index of each of the two files. 
For example: X_Axis_Wipe50_15  

   

Axis Name  Speed Index 

 

 To download the speed configurations: 

1. In the S-Curve Files Handling window, select the Axis name and 
Speed Index, according to information that you noted for the first of 
the two files.  

2. Click the Input S-Curve file Browse button  and browse to: 
Breeze921\Common\Bin\Curves.  

3. Select the first file (that stores the new configurations). 
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NOTE: 

If the Axis name and/or the Speed Index are not appropriate for the 
downloaded file, the following warning appears (in Red print) and the Download 
S-Curve button is disabled. 

 

When the Axis name and/or the Speed Index are appropriate for the 
downloaded file, the following message appears (in Green print) and the 
Download S-Curve button is disabled. 
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4. Click Download S-Curve; the first axis configuration is downloaded 
to the system. 

5. Again, in the S-Curve Files Handling window, select the Axis name 
and Speed Index, according to information that you noted for the 
second of the two files. 

6. Click the Input S-Curve file Browse button  and browse to: 
Breeze921\Common\Bin\Curves.  

7. Select the second file (that is holding the new configurations). 

8. Click Download S-Curve; the second axis configuration is 
downloaded to the system. 

 To upload the system's speed configurations to a file for 

exportation: 

1. Select a Data Format:  

 Hexadecimal  

 Decimal  

2. Click Upload S-Curve; the S-Curve configurations appear in the 
Uploaded S-Curve Information pane. 

3. Click Save Uploaded S-Curve to File; the Save As window 
appears. 

4. Browse to the folder in which you want to save the new 
configurations. 

5. Click Save; the file is saved as a .txt file and the file path appears in 
the field below the Upload S-Curve button. 
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11 Updating the System Password 

Your system is supplied with a password that allows you to operate the 
printer. When your password expires or when you change the Main 
Board, you must update your system password (i.e. request a new 
password from Kornit and apply the password to your system). 

 

NOTE: 

 To update the system password, you must first activate the Technicians 
Mode. 

 Your password is enabled for a specified number of hours of powered-on 
printer use. Twenty hours before reaching the time limit, the system will 
inform you of the number of remaining hours of usage. 

 When the time limit has expired, the system is automatically locked. You 
will not be able to RIP files but you can still perform maintenance activities. 

 

 To update your system password: 

1. In the Main Window, click Help > About; the Kornit window 
appears.  

 
Figure 97: About Kornit 
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2. Record your Board ID number and send it to your local Kornit 
representative with your request for a password update; Kornit will 
create a new password and will send it back to you through your 
dealer. 

 

NOTE: 

For your local Kornit representative details, see Troubleshooting on page 
202. 

 

3. When you receive the new password, open the Main Window and 

click Tools > Hardware Downloads > Password; the Password 
Update window appears. 

 
Figure 98: Update Password 

4. Enter the four new groups of numbers/letters into the fields.  

5. Click Update Password; the new password is accepted and you 
can resume working with the system. 
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Chapter 7: 

Working with the Wizards 

The Working with the Wizards chapter focuses on the system wizards 
and includes: 

 Registering the Print Heads: Print Registration Wizard on  
page 140. 

 Calibrating the Print Head Position: Print Position Wizard on  
page 151. 

 Calibrating Media for Printing: Linearization Wizard on page 156. 

 

 

NOTE: 

Each wizard displays concise wizard steps. For complete operation details of 

the specific wizard, click the Wizard Information icon  . 
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1 Registering the Print Heads: Print 
Registration Wizard 

Print registration has been calibrated in the factory according to the 
print heads provided with the printer. When you install new print heads 
or when print registration is inaccurate, recalibrate using the Print 
Registration Wizard. 

1. Place an A3 or A4 transparency onto the printing pallet, aligned to 
the bottom-right corner of the printing pallet. 

 

NOTE: 

The Print Registration Wizard has been programmed to work with either 
Standard or Children's printing pallets. The number of printed tests on one 
transparency depends on the printing pallet size.

 

 
Figure 99: Aligning Transparency 

2. From the Main Window, click Tools > Calibration > Registration 

Wizard; the Print Registration wizard appears, displaying the Head 
Left/Right Calibration window. 

Transparency 
 
Bottom-right corner 

Printing Pallet 
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 To navigate through the Registration Wizard: 

Click Print  in the application or press the green printer Start 
button on the printer to print the specific test file. 

At any stage of the Print Registration wizard: 

 Click Back , to repeat the specific procedure enabled by 
the window. 

 Click Next , to proceed to the next procedure. 

 Click Cancel , to exit the wizard. 

 Select the Use White checkbox , to complete the full 
registration procedure, including registration of the white print 
heads.  

 Click Reset , to reset the registration numbers to zero. 

 Click P&W , to purge and wipe the print heads. 

 

Attention: 

Before performing any of the wizard test prints, verify that the distance between 
the printing pallets and the print heads is 2 mm.
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1.1 Performing Head Calibration 

In Step 1, Head Left/Right Calibration, the printer prints left and right 
along the scan axis. This step calibrates between the left and right print 
directions for each print head.   

 
Figure 100: Step 1_Head Left/Right Calibration Window 
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 To perform Head Left/Right Calibration: 

1. Click the Print button; the printer prints out the Head Left/Right 
Calibration test. 

 
Figure 101: Step 1_ Head Left/Right Calibration Window – Close-up 

2. Examine the printout; for each print head, determine which cross 
has the most precise color overlap. 
In the example below, cross 2 has the most precise overlap. 

 

 
Figure 102: Head Left/Right Calibration - Magnified 

 

Cross 0 
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a. For each print head, examine the calibration test for the three 
most precisely overlapping X's. 

b. Enter the average Cross number into the Registration 
Number fields (for each print head).  

3. Click the Print button to print out a second test print: 

 If Cross 0 does not have the most precise overlap, the 
calibration was not precise enough; repeat steps ‎2 and ‎3. 

 If Cross 0 has the most precise overlap, the calibration was 
precise; proceed to the next step. 

4. Click Next; the Head to Head Scan Calibration window appears. 
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1.2 Performing Head to Head Scan 

Calibration  

In Step 2, Head to Head Scan Calibration, the printer calibrates all of 
the print heads along the scan axis. In this step, the printer prints 
vertical black reference lines on top of CMY and white colored lines. 

 

Figure 103: Step 2_Head to Head Scan Calibration Window 

Numbered 
Overlapping 

Lines 
 
 
 
 

Registration 
Number Fields 

 



146  Kornit Breeze User Guide 

Last printed: 1/11/2012 4:38:00 PM 

Last saved: 1/11/2012 4:38:00 PM 

 To perform Head to Head Scan Calibration: 

1. Click the Print button; the printer prints out the Head to Head Scan 
Calibration test. 

 

Figure 104: Head to Head Scan Calibration Test – Close-up 

2. Examine the printout; determine the group of lines that has the 
most precise overlap. 
In the example below, group 2 has the most precise overlap. 

 
 

 

Figure 105: Head to Head Scan Calibration Test - Magnified 
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3. For each print head:  

a. Examine the Main Calibration test for the most precisely 
overlapping lines. 

b. Examine the Secondary Calibration test for the three most 
precisely overlapping group of lines. 

c. Enter the Group number into the Registration Number fields. 

4. Click the Print button to print out a second test print: 

 If Group 0 does not have the most precise overlap, repeat steps 
2 to 3. 

 If Group 0 does have the most precise overlap, continue with 
the following step. 

5. Click Next; the Head to Head Cross Scan Calibration window 
appears. 
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1.3 Performing Head to Head Cross Scan 

Calibration 

In Step 3, Head to Head Cross Scan Calibration, the printer calibrates 
all of the print heads along the cross scan axis. In this step, the printer 
prints horizontal black reference dashes on top of CMY and white 
colored dashes. 

 
Figure 106: Step 3_Head to Head Cross Scan Calibration Window 
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 To perform Head to Head Cross Scan Calibration: 

1. Click the Print button; the printer prints out the Head to Head Cross 
Scan Calibration test. 

 

Figure 107: Head to Head Cross Scan Calibration Test – Close-up 

2. Examine the printout; determine the group of dashes that have the 
most precise overlap. 
In the example below, group 2 has the most precise overlap. 

 

 

Figure 108: Head to Head Cross Scan Calibration Test – Magnified 

Group 0 

Group No. 
 
Secondary 
Calibration 
 
Main 
Calibration 
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3. For each print head: 

a. Examine the Main Calibration test for the most precisely 
overlapping dashes. 

b. Examine the Secondary Calibration test for the three most 
precisely overlapping group of dashes. 

c. Enter the Group number into the Registration Number fields 
(for each print head). 

4. Click the Print button to print out a second test print; 

 If Group 0 does not have the most precise overlap, repeat steps 
2 to 3. 

 If Group 0 has the most precise overlap, proceed to the next 
step. 

5. Click Finish; the Print Registration wizard closes. 
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2 Calibrating the Print Head Position: 
Print Position Wizard 

Use the Print Position Wizard when you recognize inaccurate print 
positioning. 

The Print Position Wizard enables you to calibrate the correct print 
location, using the bottom-right pallet screw as the point of reference. 

 

To determine the precise print location on the standard printing pallet, 
perform the following procedures: 

 Identify the present print location on the printing pallet. 

 Calibrate the correct print location on the printing pallet. 

Bottom-right pallet screw 
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 To identify the present print location on the printing pallet: 

1. Place a transparency onto the printing pallet, aligned to the  
bottom-right corner. 

 
Figure 109: Aligning the Transparency 

2. From the Main Window, click Tools >Calibration > Print Position 

Wizard, the Print Position Wizard appears. 

 
Figure 110: Print Position Wizard  

3. Click P&W to purge and wipe the print heads. 
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4. Click Print; the printer prints out a Print Position Calibration test. 

 If the printed position appears directly over the bottom-right 
pallet screw; the print location on the printing pallet is correct. 

 
Figure 111: Correct Print Alignment 

 If the printed position does not appear directly over the bottom-
right pallet screw; the print location on the printing pallet is 
incorrect and needs to be adjusted. 

 
Figure 112: Incorrect Print Alignment 

 
NOTE: 

When the printed position does not appear directly over the bottom-right pallet 

screw, click the Reset button and the click the Print button; if the print location 
is still incorrect, continue with the "To calibrate the correct print location on the 
printing pallet" procedure on page 154. 

 

Printed position 
 

Bottom-right pallet screw 

Printed position 
 

Bottom-right pallet screw 



154  Kornit Breeze User Guide 

Last printed: 1/11/2012 4:38:00 PM 

Last saved: 1/11/2012 4:38:00 PM 

 To calibrate the correct print location on the printing pallet: 

1. Using a ruler, measure the horizontal and vertical distances from 
the center of print position to the center of the bottom-right pallet 
screw. 

 
Figure 113: Measuring Horizontal and Vertical Distance 

2. Move the adjusters according to the horizontal and vertical distance 
from the center of the cross-hairs and the center of the pallet 
screw. 

 
Figure 114: Moving the Adjusters 
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NOTES: 

 The adjusters register the distance in microns. One millimeter = 1000 
microns. 

 To move the print position, move the sliders in the direction that you want 
to move the print or enter the appropriate numbers into the adjuster scroll 
boxes. 

 

3. Erase the printed position from the transparency, using a paper 
towel. 

4. Click Print again; the printer prints out a new Print Position test. 

5. If the printed position does not appear directly above the bottom-
right pallet screw; repeat steps 1 – 5, until the printed position is 
correct. 

6. When you have completed all of the identification and calibration 

procedures, click the Close button . 
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3 Calibrating Media for Printing: 
Linearization Wizard 

Using a color measurement device and the Linearization Wizard,  you 
can calibrate various types of media for printing with preferred colors 
and density.  

 

NOTE: 

 Currently, Kornit only supports the X-Rite Eye-One automatic densitometer 
measuring device. To purchase this device, contact your local Kornit 
representative. 

 For your local Kornit representative details, see Troubleshooting on  
page 202. 

 A CD is included with the X-Rite eye-one measuring device. The CD data 
must be loaded into the printer computer before performing the 
Linearization wizard procedures for the first time.  

 8-bit files can be printed directly, using the calibration tables created with 
the Linearization wizard. In many cases, this will enable you to print quality 
images without the use of third-party RIP software.  
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 To calibrate the media using an automatic densitometer: 

1. Connect the measurement device to a USB outlet. 

2. Select Use Eye-One densitometer; the Calibrate button is 
activated. 

 
Figure 115: Linearization Wizard – Step 1 

3. Select a Light Colors option: 

 None (recommended) 

 CM 

 CMYK 
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4. Click the Calibration button; a message dialog box appears and 
instructs you to put the Eye-One on the white tile and to press the 
Densitometer Scan button. 

 

NOTE: 

If the Eye-One densitometer is not properly connected, the following 
message appears: 

 
If this message appears, verify that the eye-one is properly connected to 
the Kornit printer. 

 

5. Align the Eye-One device on the white tile (the white dot in the 
cradle) and press the Densitometer Scan button on the side of the 
Eye-One; the message on the Step 1 - Densitometer Type window 
changes initially to Please Wait and then to Calibration Done.  

 
Figure 116: Align the Eye-One on the White Tile 

Densitometer 
Scan Button 

 
 

White Tile 

 

Cradle 
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6. Click Next; the Resolution and Ink Restriction window appears.  

 
Figure 117: Linearization Wizard – Step 2 

7. Define the Dark ink restrictions.  

 

NOTE: 

Dark ink restrictions enable you to determine at what ink concentration 
bleeding occurs. Therefore, begin by making a print file where "Dark ink 
restrictions" has been defined at approximately 85. You can make 
additional files where "Dark ink restrictions" has been reduced, until you 
produce a file that has no bleeding. 

 

8. Select the CMYK resolution X and Y values from the dropdown 
menus (e.g. 545).  

9. If printing with white ink, select the White resolution X and Y 
values from the dropdown menus. 

 

NOTE: 

Define the resolution according to the resolution that you normally use 
when printing. 

The higher the resolution, the more color density is printed and therefore 
the slower the printing speed. If bleeding starts at under 70% ink coverage, 
reduce the Print Resolution. Bleeding under 70% means that the resolution 
that was used in the test was too high for the media and is wasteful (i.e. 
reduce the resolution from 545 to 455 or from 455 to 363). 
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10. Open the Screen mode dropdown menu and select an option: 

 Stochastic – Recommended 

 Linear  

 Diamond  

11. Click Next; the Chart Creation window appears. 

 
Figure 118: Linearization Wizard – Step 3 

12. Click Print to file; the Print Parameters window appears. 

 
Figure 119: Print Parameters Window 
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13. Select a Print white background level option: 

 None – No white background will be printed. (recommended) 

 Single – One layer of white background will be printed. 

 Double – Two layers of white background will be printed. 

 

NOTE: 

When you select "None" as the White Print Mode option, the following 
options are disabled: 

 White Highlight (%). 

 White Under Light Colors (%). 

 White Under Dark Colors (%). 

When you select "Single" or "Double", the three sliders control the printed 
white layer: 

 The White Highlight (%) slider controls the opacity of the white areas 
beneath CMYK colors of 0 – 5% opacity. 

 The White Under Light Colors (%) slider controls opacity of the white 
layer that is printed underneath light colors. 

 The White Under Light Colors slider position determines the 
maximum amount of white that can appear under a CMYK color 
that has opacity of 5-100%. 

 The White Under Dark Colors (%) slider controls opacity of the white 
layer that is printed underneath dark colors.  

 The White Under Dark Colors slider position determines the 
minimum amount of white that can appear under a CMYK color 
that has opacity of 5-100%. 

 

14. If enabled, move the slide tools to specify the opacity of the white 
areas.  



162  Kornit Breeze User Guide 

Last printed: 1/11/2012 4:38:00 PM 

Last saved: 1/11/2012 4:38:00 PM 

15. Click Print to file; the Save As window appears. 

 
Figure 120: Save As  

16. Select the folder in which to save the file, enter the file name and 

click Save; the print file is saved and the Chart Creation window 
reappears. 

17. Minimize the Chart Creation window; the Breeze application regains 
focus. 

18. In the job queue, click New File and load the print file into the job 
queue. 

 
Figure 121: Main Window 
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19. If necessary, drag and drop the file to the top of the queue. 

20. Double-click the print file in the job queue to access the File Details 
window to enter the following parameters (see File Details Window 
on page 22): 

 Spray Amount – Select the required spray amount from the 
dropdown list, according to the selected media type. 

 Media Name – Enter the media name. 

 

NOTE: 

 The thickness of the media is predefined for each media.  

 The print file is saved as 1Bit image file; therefore, some of the setup 
parameters have been disabled. 

 

21. Place a garment on the printing pallet and press the green printer 
Start button; the Linearization test is printed. 

22. Dry the garment. See Dryers on page 199.  

23. Examine the dried, printed garment to identify the highest ink 
coverage at which there is no bleeding. 

24. If there is bleeding, repeat procedure step ‎7 on page 159.  

 

NOTE: 

It is essential that all parameters and conditions for all aspects of this test  
(i.e. file preparation parameters using the linearization wizards and file printing 
parameters, such as spraying amount on the Kornit) are identical to those of 
the target jobs for which you will use the calibration table that this test creates.
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25. Maximize the Chart Creation window and click Next; the CMYK 
Linearization Density window appears. 

 
Figure 122: Linearization Wizard – Step 4 

26. On a flat surface, place the special Linearization ruler on the 
garment and press the Densitometer Scan button.  

27. In the CMYK Linearization Density window, the color (to be 
scanned) blinks and a message appears requesting that you scan 
the first row of the cyan (from light to dark). 

28. Place the densitometer on the white area adjacent to the lightest 
color in the row, press (without releasing) the Scan button, and wait 
for a beep. 

 
Figure 123: Pressing the Scan button 
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29. After the beep, slowly slide the densitometer across the colors and 
at an even speed, until it reaches the white area on the other side 
(adjacent to the darkest color in the row). 

30. Release the Scan button.  

 
Figure 124: Sliding the densitometer to the right 

 

NOTE: 

 You do not hear a "beep" sound when you release the Scan button. 

 Slide the densitometer at an even speed to prevent the densitometer from 
reading a patch twice. 

 Each time you perform the measurement and release the densitometer's 
Scan button, the relevant values are entered into the table featured in the 
window.  

 If a scan fails, the message: "Scan failed. Please try again" appears and 

the same color continues to blink. Repeat steps ‎29 and ‎30 until scanning 
succeeds. 

 Make sure that you scan the correct color (i.e. the color that is blinking in 
the application window). 

 

After you succeed in scanning the current color, the results are 
displayed in the graph on the right of the window. A message is 
displayed instructing you to scan the next color, which is now blinking in 
the window.  

Each time you succeed in scanning a color row, move the ruler up to 
the next color row, according to the instructions displayed in the 
window. 
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After all the color rows have been scanned, all the color density 
measurements are displayed on the left and the results graph is 
displayed on the right. At the bottom of the left pane, the "Scan done" 
message appears.  

 
Figure 125: Scan Done Message 

31. Click Next; the Save Linearization Table window appears. 

 
Figure 126: Save Linearization Table 
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32. Click Save; the Save As window appears. 

 
Figure 127: Save As Window 

33. In Save in, enter the media database folder path 
(Common/MediaDB). 

34. Enter the file name and click Save; the file is saved as a .lut (Look 
Up Table) file type and the window closes. 

35. In the Save Linearization Table, click Finish; the saved file can now 
be used when loading job files. For more information on loading job 
files, see Verifying and Preparing Your Graphic Image Files on 
page 90. 

36. Repeat the Linearization Wizard from the beginning and, for all 
resolutions in use in your business, redefine the Dark Ink 
Restrictions. See procedure step ‎7 on page 159. 

 Creating a new media using the new LUT definitions: 

1. From the Main Window, click Tools > Media Data Base; the Media 
Database window appears. 

2. Select a (factory) media that reflects the same resolution as that 
used in the wizard print. 

3. Change the media name and from the LUT dropdown menu, select 
the LUT file saved in procedure step ‎33 on page 167. 

4. Click Save; the new media appears in the Setup Details Media 
database list. 
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Chapter 8: 

Maintaining the System 

The Maintaining the System chapter deals with the activities that you 
can manually perform, in order to test and/or correct system 
functionality. 

Maintaining the System includes: 

 Maintaining the Printer from the LCD Maintenance  on page 170. 

 Maintaining the Printer from the Operator Window on page 176. 
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1 Maintaining the Printer from the 
LCD Maintenance Panel 

 
Figure 128: LCD Maintenance Panel 

The LCD Maintenance Panel provides you with an ongoing visual 
report of the printer and enables you to perform various maintenance 
activities.  

The LCD Maintenance Panel is composed of: 

 An LCD Report Screen 

 Operation Status Indicators 

 Command Buttons 
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1.1 LCD Report Screen 

 
Figure 129: LCD Report Screen 

In the LCD Report Screen, you can view: 

 System status (i.e. initializing, ready, cleaning). 

 Ink system vacuum (NP refers to Negative Pressure). 

 Ink system status. 

1.1.1 System Status 

System Status can be one of the following: 

 Initializing – The system is in the "starting up" process.  

 Cleaning – The system is performing automatic cleaning 
procedures before beginning the printing procedures.  

 Ready – The system is ready to perform printing procedures. 

1.1.2 Ink Subsystem Vacuum Status 

When the system is operating, a vacuum (negative air pressure) is 
applied to the ink subsystem to prevent ink from dripping from the print 
heads. 

The Vacuum status changes color as follows:  

 Green color – The vacuum is in range. 

 Red color – The vacuum is out of range. 

 

NOTE: 

Kp represents kilopascal. 

 

Ink System Status System Status 
 
 
 
 
 

Vacuum Pressure 
Amount and Status 
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1.1.3 Ink Subsystem Status 

The ink subsystem status icons are located on the top-right of the 
panel. There are three ink subsystem icons types: 

  Full Inkpot – There is sufficient ink to print the next job. 

  Empty Inkpot – There is insufficient ink to print the next job. 

 Inkpot Fills and Empties – The ink subsystem is presently being 
filled with ink. 

1.2 Operation Status Indicators 

The console panel features the following two indicators: 

 Power Indicator – Green light indicates that the system power is on. 

 Hardware System Error Indicator – Red light indicates that there is 
an error in the hardware system. 



 Maintaining the System  173 

Last printed: 1/11/2012 4:38:00 PM 

Last saved: 1/11/2012 4:38:00 PM 

1.3 Command Buttons 

 
Figure 130: LCD Maintenance Panel Close-up 

The console panel features the following command buttons:  

 F1 – Activates the Turn Off procedure.  

 F2, F3, F4 – Presently not in use. 

  Online/Offline – Disconnects and connects the 
communication between the printer and the computer.  

  Spray All – Activates the fixation spray system to spray the 
entire printing pallet surface.  

 When there is a job in the queue, the spray amount is defined 
in the job.  

 When there is no job in the queue, the spray amount is defined 
by the default in the Operator window/Spray All window. 

  Purge and Wipe – Activates the Purge and Wipe procedure. 
See Purging and Wiping the Print Head Nozzles on page 179. 

  Nozzle Test – Initiates a Nozzle Test. See Performing a 
Nozzle Test on page 68. 
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NOTE: 

The Online/Offline, Spray All, and Nozzle Test command buttons are 
enabled only when the printer is connected to the computer that is running 
the Kornit application. 

The Purge & Wipe command button is always enabled. 
 

  Abort – Stops the printing process. You cannot restart from 
where you left off. 

  Pause – Stops the printing process. You can restart from 
where you left off. 

  Menu – Click to replace the LCD Report Screen with the LCD 
Maintenance Panel menu. See LCD Maintenance Panel Menu Map 
on page 175.  Click a second time on the Menu button to regain the 
LCD Report Screen. 

 Menu Direction Buttons – Enable you to navigate in the LCD 
Maintenance Panel menu. 

  – Displays further menu options. 

  – Returns you to the master option. 

  – Enables moving up in the menu. 

   – Enables moving down in the menu. 

 Enter – Accepts the LCD Maintenance Panel menu selection. 

 Printing Pallet and Print Head Assembly Direction Buttons:  

  – Enables moving the print head assembly to the right. 

  – Enables moving the print head assembly to the left. 

  – Enables moving the printing pallet away from you. 

   – Enables moving the printing pallet towards you. 

 

NOTE: 

When moving the printing pallet from the Capping or Spit position, the 
maintenance tray is first automatically lowers to the Down position.  
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1.3.1 LCD Maintenance Panel Menu Map 

The diagram below represents the LCD menu structure. 

 
Figure 131: LCD Maintenance Panel Menu Map 
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2 Maintaining the Printer from the 
Operator Window 

From the Operator window, you can perform: 

 Maintaining the Ink System on page 177. 

 Maintaining the Spray System on page 181. 

 Maintaining the Axes System on page 183. 

 To access the Operator window: 

1. From the Main Window, click Maintenance > Operator; the 
Operator window appears.  

 
Figure 132: Operator Window 
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2.1 Maintaining the Ink System 

The ink pumps draw the ink from the ink bottles, along the ink paths, 
and into the secondary ink tanks where floater sensors monitor the 
level of ink in each tank. From the secondary tanks, the ink flows to the 
print heads.  

During the printing process, the system automatically and constantly 
fills the secondary ink tanks, enabling a smooth and steady flow of ink 
to the print heads. 

 

NOTE: 

To reset the automatic refill system, see Ink Reset in Head Properties on page 
44. 

 

However, certain procedures, such as Purge, use large amounts of ink 
and can cause the ink levels to rapidly drop.  

From the Operator window, you can monitor the levels of the 
Secondary Ink Tanks at all times and perform the following manual ink 
procedures. 

 Purging the Print Head Nozzles on page 178. 

 Purging and Wiping the Print Head Nozzles on page 179. 

 Spitting Ink through the Print Head Nozzles on page 180. 

 Nozzle Test. See Performing a Nozzle Test on page 180. 
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2.1.1 Purging the Print Head Nozzles 

Force small amounts of ink out through the nozzles to clear the print 
heads.  

 To purge the print head nozzles: 

1. In the Operator window, click the checkboxes to select the print 

heads that you want to purge or click Select All, to select all of the 
print heads. 

 
Figure 133: Ink Valve Controls 

2. In the Sec box                      , set the purge time to 0.8 seconds. 

 
IMPORTANT NOTE: 

Do not enter a purge time greater than 2.5 seconds. 

NOTE: 

If you have Operator privileges, the Sec box appears inactive. To make purge 
time changes, you must have Technician privileges. See Activating the 

Technicians Mode on page 112. 
 

3. Click Purge; the green button indicator light appears and the 
following occurs: 

a. The print heads move along the Scan axis to a position 
above the maintenance tray. 

b. The maintenance tray moves up to the print heads, leaving a 
2mm gap. 

c. Pressure is applied to the ink tanks, pushing the ink from the 
tanks to the print heads for the allotted time. 
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2.1.2 Purging and Wiping the Print Head Nozzles 

Force small amounts of ink out through the nozzles to clear the print 
heads. Following a purge, move the print heads across the wipers to 
remove excess ink and prepare the print heads for printing.  

 To purge and wipe the print head nozzles: 

1. In the Operator window, click the checkboxes to select which print 

heads to purge or click Select All, to select all of the print heads. 

2. In the Sec box                      , set the purge time to 0.8 seconds. 

 

IMPORTANT NOTES: 

 Do not enter a purge time greater than 2.5 seconds 

 If you have Operator privileges, the Sec box appears inactive. To make 
Purge time changes, you must have Technician privileges. See Activating 
the Technicians Mode on page 112. 

 

3. Click Purge & Wipe; the green button indicator light appears and 
the following occurs: 

a. The print heads move along the Scan axis to a position 
above the maintenance tray. 

b. The maintenance tray moves up to the print heads, leaving a 
2mm gap. 

c. Pressure is applied to the ink tanks, pushing the ink from the 
tanks to the print heads for the allotted time. 

d. The maintenance tray moves to the wiping position (the 
wipers are level with the print heads). 

e. The print heads move across the wipers to clean the excess 
ink. 



180  Kornit Breeze User Guide 

Last printed: 1/11/2012 4:38:00 PM 

Last saved: 1/11/2012 4:38:00 PM 

2.1.3 Spitting Ink through the Print Head Nozzles 

The Spit procedure keeps the print heads unclogged and moist for 
printing. During the procedure, the print heads move to the service 
area and the maintenance tray moves to the spit position under the 
print heads, to collect the ink that is fired. 

 
NOTE: 

The printer automatically performs the spit procedure after a predetermined 
time elapses between printing procedures. 

 

 To spit ink through the nozzles: 

In the Operator window, click Spit; the following occurs: 

1. The print heads move along the Scan axis to a position above the 
maintenance tray. 

2. The maintenance tray moves to the Spit position. 

3. The print heads periodically release (spit) ink.  

2.1.4 Performing a Nozzle Test 

When you suspect that some nozzles are clogged or not working 
properly, you can perform a Nozzle Test. See Performing a Nozzle 
Test on page 68.  
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2.2 Maintaining the Spray System 

From the Operator window, you can manually perform the following 
spray activities:  

 Spray All – Spray the entire printing pallet area with the printing 
spray. 

 Spray Current Job Area – Spray only the printing area defined by 
the first job in the job queue. 

 To spray the entire printing pallet area: 

1. Click Spray All…; the Spray All window appears displaying spray 
amount, wipe, and spray area settings as defined in the Job Setup. 

 
Figure 134: Spray All Window 

2. If required, change the Choose Spray Amount % and Wipe 
settings.  

3. Clear the Current Job Area checkbox. 

4. Click OK to spray the entire printing pallet area; the printing pallet 
moves into the spray position and the system sprays the printing 
pallet area according to the Spray All settings. 
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 To spray the current job area only: 

1. Click Spray All…; the Spray All window appears displaying spray 
amount, wipe, and spray area settings as defined in the Job Setup. 

 
Figure 135: Spray All Window 

2. If required, change the Choose Spray Amount % and Wipe 
settings.  

3. Select the Current Job Area checkbox. 

4. Click OK to spray the current job area; the printing pallet moves 
into the spray position and the system sprays the job area 
according to the Spray All settings. 
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2.3 Maintaining the Axes System 

 

 

 
Figure 136: Maintenance Panel  Figure 137: Move Axis Panel 

From the Operator window, you can activate the various axes and 
manually: 

 Move the printing pallet to the following positions: 

 Home 

 Load  

 Move the print heads to the following positions: 

 Capping  

 Spit  

 Move the maintenance tray to the following positions: 

 Capping 

 Wiping  

 Spit 

 Printing  
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2.3.1 Moving the Axes to the Home Position 

You can move the printing pallet and the print head carriage to their 
respective Home positions.  

 To move the printing pallet and the print head carriage to the 

Home position: 

In the Operator window, click Home; the printing pallet moves to the 
backside of the printer and the print head carriage moves to the 
extreme right of the printer. 

2.3.2 Moving the Printing Pallet to the Load 

Position 

The load position is the printing pallet position closest to you. This is 
the printing pallet position for loading the garment.  

 To move the printing pallet to the load position: 

In the Operator window, click Load Position. 

2.3.3 Moving the Print Head Carriage to the 

Capping Position  

You can move the print head carriage across the Scan axis to the 
Capping position.  

 To move the print head carriage to the capping position: 

In the Operator window, click Capping Position.  

2.3.4 Moving the Print Head Carriage to the Spit 

Position 

You can move the print head carriage across the Scan axis to the Spit 
position.  

 To move the print heads to the Spit position: 

In the Operator window, click Spit Position. 
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2.3.5 Moving the Maintenance Tray to the Capping 

Position 

In the Capping Position, the printing pallet moves to the load position, 
the print head carriage moves to a position above the maintenance tray 
and the maintenance tray rises up until it closes on the print heads.  

 To raise the maintenance tray to the capping position: 

In the Operator window, click Capping.  

2.3.6 Moving the Maintenance Tray to the Wipe 

Position 

In the Wipe position, the printing pallet moves to the load position, the 
print head carriage moves to a position above the maintenance tray, 
and the maintenance tray moves either up or down until the wipers are 
level with the print heads.  

 To raise the maintenance tray to the wipe position: 

In the Operator window, click Wipe. 

2.3.7 Moving the Maintenance Tray to the Spit 

Position 

In the Spit position, the printing pallet moves to the load position, the 
print head carriage moves to a position above the maintenance tray, 
and the maintenance tray moves either up or down to a level below the 
Wipe position.  

2.3.8 Moving the Maintenance Trays to the Down 

Position 

In the Down position, the printing pallet moves to the load position, the 
print head carriage moves to a position above the maintenance tray, 
and the maintenance tray lower down to the lowest position on the Z 
axis.  

 To lower the maintenance trays to the down position: 

In the Operator window, click Down. 
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Chapter 9: 

Appendix 

The appendix provides you with information on the following subjects: 

 Hot Folder on page 188. 

 Dryer on page 199. 

 Troubleshooting on page 202. 

In addition, the appendix provides you with the following information 
and tools for maintaining your system: 

 Daily Maintenance Checklist (for Work Day) on page 218. 

 Daily Maintenance Checklist (for Work Shift) on page 219. 

 Weekly Maintenance Procedures on page 220. 
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1 Hot Folder 
The Kornit Breeze supports automatic file loading from a predefined 
Hot Folder.  

Towards this end, by default, the following four Hot Folders are located 
inside the Common folder. 

 Hot Folder – Triggers the software to "pull" the file.  The file is 
erased from the hot folder and loaded to the printer job queue. 

 Hot Folder Working – The loaded file is saved in the hot folder until 
the printing process is completed or until the file is erased from job 
queue. 

 Photoshop Working – The file is automatically saved in this folder 
when Photoshop is working on the file. The file is deleted from the 
folder after it is printed or deleted from queue. 

 Hot Folder Error – Files that cannot be loaded to the job queue are 
sent to this folder. 

 
NOTE: 

You can reset the hot folder path from the Parameters Handling window. See 
Handling Parameters on page 125. 

 

Files that have been sent to the input hot folder are loaded 
automatically and will be ripped according to the parameters in the file 
name. 

Kornit Breeze samples the folder every few seconds. Upon 
identification of a new file, the file is automatically loaded, providing that 
the file name matches the defined pattern.  

The files are loaded in FIFO order (First In First Out). If Kornit Breeze 
fails to load a specific file due to a problem with the file name, for 
example if the setup name is not correct, the file is moved to an error 
folder (C:\Program Files\Kornit Digital\QuickP\Error).  

1.1 Naming the Image File 
According to whether or not the file was prepared in Kornit's QuickP 
Designer software, Breeze provides you with two naming options: 

 The file not prepared in the QuickP Designer. 

 The file prepared with the QuickP Designer. 
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1.1.1 File Not Prepared in QuickP Designer 

File names must match the following structure: 

 

 

 Parameter Refers to: 

1 Setup A setup file that was defined in Kornit Breeze for a specific 
type of media (white/dark garment etc). 

2 Table A printing pallet that is available to your Kornit printer and 
which has been defined in your Kornit Breeze software. 

3 Filename The name of the image file. 

4 Copies The number of copies to be printed. 

5 Xshiftmm The distance in millimeters from the left side of the table's 
printable area to the left edge of the image to be printed. 

6 Yshiftmm The distance in millimeters from the top side of the table's 
printable area to the top edge of the image to be printed. 

Each of the parameters is described in further detail in the subsequent 
sections. 

Files are saved in the .png format which is a compressed file that 
supports transparent files – an essential property for printing on dark 
textiles. When a file is saved, the size of the image and its resolution 
are automatically saved with it. This information is used by the Kornit 
printer when the file is loaded for printing. 

Example File Name: 
LightTNormal545_Normal_Horseimage_5_10_40.png 

Indicates a transparent PNG file name (Horseimage) using a 
predefined setup called LightTNormal545.  It will print 5 copies on a 
Normal sized printing pallet with the image location being shifted right 
10 mm and down 40 mm from the table top left corner. 

setup_table_filename_copies_xshftmm_yshiftmm.tif 

       

1 2 3 4 5 6  
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1.1.2 Files Prepared in QuickP Designer 

When preparing files using QuickP Designer, you have two options for 
processing: 

 8-bit 

 1-bit 

Processing 8-bit Files 

When you process the file as an 8-bit file, the following two files (with 
identical names) are created: 

 File_name.tif – The image file. 

 File_name.ksf – The Job Ticket. 

Both files should be copied to the hot folder. 

Processing 1-bit Files 

When you process the file as a 1-bit file, the following six files (with 
identical names) are created: 

 File_name_C.tif, File_name_M.tif, File_name_Y.tif, File_name_K.tif, 
File_name_W.tif – Separation files. 

 File_name.ksf – The Job Ticket. 

All files should be copied to the hot folder. 

 

NOTE: 

The files are loaded in FIFO order (First In First Out). If the application fails to 
load a specific file due to a problem with the file name or the .ksf file, the file is 
moved to an error folder. 
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1.1.3 Setup 

Breeze setup files define the media. According to the setup file 
selected for a specific image file, the printer prepares/processes the file 
after it has been uploaded to the hot folder. 

The program must know to select the correct setup file according to the 
selected garment. 

The Factory Setup Options include: 

 LightTNormal545 

 LightTMidContrast545 

 LightTHighContrast545 

 LightTManual545 

 LightTSkinTone545 

 BlackManual545x454 

 BlackTHigh545x454 

 BlackTHighInterlace545x454 

 BlackTHighStroke545x454 

 BlackTMid545x454 

 BlackTMidFullFrame545x454 

 BlackTMidFullFrameInterlace545x454 

 DarkT545x454 

 DarkTInterlace545x454 
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1.1.4 Printing Pallet 

The selected printing pallet determines the maximum printable area. 

The printing pallet parameter should contain the name of the printing 
pallet on which the selected garment should be printed and should 
match one of the printing pallets defined in your Breeze system.  

The program needs to automatically relate each garment size that can 
be selected to one of the available printing pallets. 

The position of the image on the garment is calculated according to the 
distance of the top-left corner of the image from the top-left corner of 
the table printable area. For more details on calculating the position, 
see Xshiftmm and Yshiftmm on page 194. 

The pallet type should match the Kornit printing pallet names. 

Available printing pallet types: 

 Normal (Standard) pallet. 

 Children's pallet. 

 

NOTE: 

Before sending a processed file to the machine, make sure that the same 
pallet type is currently defined in the system. 
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1.1.5 Filename 

The filename parameter should be the order number and should 
include an indication of the exact garment type required (i.e. color, size, 
style of the garment, etc). 

The order details should also be sent to the warehouse. Receipt of the 
order number enables the warehouse manager to select the correct 
garment (color/size/style) to be loaded on the machine. 

Kornit recommends that you work with barcode producing software and 
a barcode reader. The barcode should be generated together with the 
order and should also include the garment details (size, color, style, 
etc) and the barcode reader should be connected to the Kornit printing 
station computer. This ensures that the correct image file will be loaded 
and printed on the correct garment. 

1.1.6 Copies 

The copies parameter indicates the number of copies of the selected 
image to be printed. 
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1.1.7 Xshiftmm and Yshiftmm 

Xshiftmm – The distance in millimeters from the left side of the 

printing pallet printable area to the left edge of the image to be printed. 

yshiftmm – The distance in millimeters from the top side of the 
printing pallet printable area to the top edge of the image to be 
printed.            

Xshiftmm = 0 and yshiftmm = 0  Indicates that the image starts 
printing in the top left corner of the table printing area, not 
necessarily the space allocated in the website. 
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2 Printing Pallets 

 

 

 
Figure 138: Standard Printing Pallet 

The Printing Pallets section provides you with the following information: 

 Printing Pallet System Description on page 196. 

 Pallet Types on page 196. 

 Replacing the Printing Pallet on page 198. 
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2.1 Printing Pallet System Description 

You install the printing pallet on the pallet base.  

  
Figure 139: Pallet Base Figure 140: Installed Pallet 

The printing pallet system is comprised of the following components: 

 Pallet Base – Fixed, flat surface onto which the printing pallet is 
installed. The pallet base has four gold-colored, threaded, screw 
holes that align with the screw holes on each printing pallet. These 
screw holes enable you to firmly fix the printing pallet to the pallet 
base. 

 Pallet Screws – Fasten the printing pallet to the pallet base by four 
special screws. Loosen or tighten these screws with a 4 mm Allen 
Key. 

 Magnetic Pallet Frame – Device for holding the garment in place 
during spraying and printing. 

 

CAUTION! 

Do not use force when tightening the printing pallet as over-tightening can 
cause the printing pallet to become unleveled. 

 

 



 Appendix  197 

Last printed: 1/18/2012 9:38:00 AM 
Last saved: 1/11/2012 4:31:00 PM 

2.2 Pallet Types 
The Breeze can print with the following printing pallets:  
• (Normal) Standard Pallet 
• Children's Pallet 

2.2.1 Normal (Standard) Pallet 
The Normal (Standard) Pallet (P/N 33-TABL-0002) is for printing on t-
shirts and garments that fit the printing pallet size. 

Maximum Printing Area: 
• Width: 365mm (14.37″) 
• Length: 460mm (18.11″) 

 
NOTE: 
Printing pallet size is about 18 mm longer (in width and in height) than the 
maximum allowed printing area. 

 

2.2.2 Children's Pallet 
The Children's Pallet (PN: 33-TABL-0006) is used for printing on 
children-sized T-shirts and garments. 

Maximum Printing Area: 
• Width: 272mm (10.8") 
• Length: 270mm (10.6") 
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2.3 Replacing the Printing Pallet 

You can replace the printing pallet with a new printing pallet or you can 
exchange the Standard and the Children's pallets.  

 

NOTE: 

Replacing a printing pallet is an uncomplicated procedure but we recommend 
that you work carefully and that you do not use force. 

 

 To replace a printing pallet: 

1. Remove the magnetic pallet frame.  

2. Remove all of the pallet screws using a 4mm Allen Key (there is no 
ordered sequence). 

3. Lift the printing pallet off the pallet base and store in a protected 
location. 

4. Place the required printing pallet onto the pallet base. 

5. Look though the pallet screw holes to verify that the gold-colored 
screw holes of the base are visible and aligned. 

6. Insert all four screws, without tightening them. 

7. Gently, but firmly tighten: 

a. The left-rear screw (furthest from you on the 
left) and then the right-front screw (closest 
you and on right). 

 

b. The right-rear screw (furthest from you on the 
right) and then the left-front screw (the 
closest to you and on the left). 

 

 

NOTE: 

The gold-colored screw holes on the pallet base are precisely leveled and 
aligned when the system is assembled. Precise positioning is very 
important for maintaining high printing standards. Therefore, do not use 
force when tightening the pallet screws. 

 

  X 
         a 
               X                   

               X 
         b 
  X 



 Appendix  199 

Last printed: 1/11/2012 4:38:00 PM 

Last saved: 1/11/2012 4:38:00 PM 

3 Dryers  

After printing, immediately remove the garment from the printing pallet 
and place it on the dryer. See Unloading a Garment from the Printing 
Pallet on page 78.  

 

NOTE: 

 The average drying time suitable for most types of garments is 4 minutes, 
at 160°C (350°F). 

 Certain garment types and colors can require changing the drying system 
and parameters (e.g. images printed with white ink require more drying 
time). 

 

The Dryer section includes: 

 Adjusting the Drying System and Parameters on page 200. 

 Dryer Specifications on page 200. 

 Recommended Dryers on page 200. 

 Testing Dryer Suitability on page 201. 
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3.1 Adjusting the Drying System and 

Parameters 

You can adjust the drying system and parameters for garment types 
and colors that require special drying times.  

For instruction on adjusting your specific drying system, consult your 
dryer supplier. 

3.2 Dryer Specifications 

We recommend that you use dryers that meet the following 
specifications:  

 Gas oven (recommended) or electric oven without IR (with hot air). 

 Minimum chamber length of 3m (10 feet). A chamber length of 4m 
is recommended. 

 Chamber temperature of 160°C (350°F) is required on belt. 

 Belt speed control. 

3.3 Recommended Dryers 

Model Company Web site 

Md8 Interchangecorp - USA www.interchangecorp.com 

Jetstream Adelco UK www.adelco.co.uk 

Triple e oven Calmat www.calmatflash.com 
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3.4 Testing Dryer Suitability 

Before using the dryer for the first time, or before mass-printing, you 
should test the performance of the dryer.  

 To test dryer suitability: 

Print a garment using all the standard procedures and parameters that 
you will be using on an ongoing basis and then: 

 Smell the image – If you can smell the fixation spray, the image has 
not dried. 

 Chafe the image with a piece of material – If ink rubs off on the 
material, the image is not dry. 

 Wash the garment to make sure that the image does not fade. 

 Examine for burning. See Burning on page 201. 

3.4.1 Burning 

A burnt image will have a yellowish color or can be cracked. 

 To correct burning: 

1. Adjust the temperature to 160°C (350°F). 

2. Dry a second garment; if the image is still burnt, or if the image 
cracks when stretching the garment, reduce the drying temperature 
for this type of garment. 
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4 Troubleshooting 

Troubleshooting provides you with solutions to problems that can arise 
while performing the printing procedure.  

Troubleshooting includes: 

 Opening Clogged Nozzles on page 203. 

 Fixing Bleeding Images on page 211. 

 Manually Filling the Secondary Ink Tanks on page 213. 

 Correcting a Malfunctioning Vacuum System on page 215. 

 Cleaning the Encoder – Technician on page 216. 

 Defining Conflicting Z Motor Parameters on page 217. 

 

If problems continue, contact your local Kornit representative: 

 

Kornit Digital Ltd  

(Head Office) 

12 Ha`Amal St., Afek Park,  
Rosh-Ha`Ayin 48092, Israel 

Tel: +972.3.908.5800 

Fax: +972.3.908.0280 
Email: support@kornitics.com 

Kornit Digital  

North America Inc 
9077 North Deerbrook Trail,  
Brown Deer, WI 53223, USA 

Toll Free: 888.456.7648 

Tel: +1.414.354.0905 

Fax: +1.414.354.0906 

Email: supportkna@kornitics.com 

Kornit Digital  

Asia Pacific Ltd 
Unit 31, 12/F., HITEC  
1 Trademart Drive,  
Kowloon Bay, Hong Kong 

Tel: +852.2.174.4100 

Fax: +852.2.174.4400 

Email: supportap@kornitics.com 

Kornit Digital  

Europe GmbH 

Halskestrasse 29, Ratingen,  
D–40880, Germany 

Tel: +49.2102.579.4075 

Fax: +49.2102.166.3538 

Email: supporteu@kornitics.com 

mailto:kornit@kornit.co.il
mailto:kornit@kornit.co.il
mailto:kornit@kornit.co.il
mailto:kornit@kornit.co.il
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4.1 Opening Clogged Nozzles 

Perform the following activities, in the order that they are listed, until 
the nozzles are unclogged:  

1. Performing the Spit Procedure on page 204. 

2. Performing Print Head Purge on page 205. 

3. Manually Performing Purge and Wipe on page 206. 

4. Repeating the Nozzle Test on page 208. 

5. Performing a Long Purge - Technician on page 209. 

 

NOTE: 

 If you have completed all procedures and the nozzles are still clogged, 
contact your local Kornit support representative.  

 For local Kornit support representative details, see Troubleshooting on 
page 202. 
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4.1.1 Performing the Spit Procedure 

Spit is a procedure that ejects ink through the print heads to keep them 
unclogged and moist. The system automatically initiates Spit after a 
predetermined time elapses between printing jobs but you can also 
manually initiate the procedure to unclog nozzles.  

 To initiate the Spit Procedure: 

1. From the Main Window, click Maintenance > Operator; the 
Operator window appears. 

2. Click the Spit button; the Spit procedure is initiated. 

4.1.2 Performing a Nozzle Test 

To perform a nozzle test, see Performing a Nozzle Test on page 68.  
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4.1.3 Performing Print Head Purge 

After you have determined which print heads are clogged, repeatedly 
purge the clogged print heads until you see that ink is dripping freely 
from the print heads and into the maintenance tray.  

 To purge a print head with clogged nozzles: 

1. From the Main Window, click Maintenance > Operator; the 
Operator window appears. 

 
Figure 141: Operator Window 

2. Select the Heads to Purge checkboxes of the print heads that you 
want to purge.  

3. Click the Purge button; the green indicator light appears during the 
purging process (you can simultaneously purge all the print heads 
or you can purge each print head separately). 

 

NOTE: 

You can repeat the Purge procedure several times. 
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4.1.4 Manually Performing Purge and Wipe 

The Purge and Wipe procedure is used for cleaning the print heads 
(e.g. to open a clogged nozzle) and/or to prepare the print heads for 
printing.  

 To manually perform purge and wipe: 

1. Select the Heads to Purge checkboxes of the print heads that you 
want to purge. 

 
Figure 142: Purge and Wipe Controls 

2. In the Sec (time) field, set the amount of time (in seconds) for the 
purging procedure. 

3. Click Purge and Wipe: 

 The maintenance tray moves up until the wipers are level with 
the print heads. 

 Ink is forced through the print heads. 

 The print heads move across the wipers and are wiped clean of 
excess ink. 

 

NOTE: 

 The green indicator light appears during purging and wiping. 

 We recommend purging and wiping after all maintenance procedures. 

 When you perform Purge, you can select a long time-period (in the Sec 
field). In contrast, do not perform Purge and Wipe for long periods. 
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4.1.5 Verifying Unclogged Print Head Nozzles 

Each print head contains a row of printing nozzles. After purging the 
Pint Head nozzles, verify that the nozzles are unplugged.   

 To verify that the print head nozzles are unplugged: 

1. Visually examine the print heads; when you successfully purge a 
print head, you can see a stripe of ink of that color appearing along 
the length of the print head.  

 
Figure 143: Stripe of Ink on Print Heads 

2. Wipe the nozzles with a lint-free wipe.  

3. Repeat the Nozzle Test to verify that the problem is resolved. See 
Repeating the Nozzle Test on page 208. 

 

NOTE: 

If the stripe of ink does not appear, there may be a more serious problem than 
a clogged nozzle, or there may be air in the system. The following section 
describes how to determine the cause of the problem. 
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4.1.6 Repeating the Nozzle Test 

Perform the Nozzle Test. See Performing a Nozzle Test on page 204: 

 If the Nozzle Test no longer shows missing printed dashes, you 
have resolved the problem.  

 If the Nozzle Test still shows missing printed dashes, determine if 
the: 

 Missing nozzles are in a different place. 

 Missing nozzles are in the same place. 

Missing Nozzles in a Different Place 

A Nozzle Test that shows the missing nozzles, in a different place than 
the initial Nozzle Test, indicates that there is air in the system.  

Missing Nozzles in the Same Place 

A Nozzle Test that shows the missing nozzles in the same place as the 
previous Nozzle Test indicates a problem specific to the nozzle area 
that does not show ink. 

Perform another purge of the print head with the problematic nozzles 
and then wipe the nozzles with a lint-free wipes.  
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4.1.7 Performing a Long Purge - Technician 

When you (the technician) determine that there is air in the system and 
you have not yet cleared the air from the system, perform a long purge 
to expel air through the manual purge valve.  

 

NOTE: 

The timing of various actions during the long purge procedure is essential. 
Therefore, we advise that you first read through this entire procedure, and only 
then perform the procedure. 

 

 To perform a long purge: 

1. Remove the print head cover. 

2. From the Main Window, click Maintenance > Operator; the 
Operator window appears. 

3. In the Purge pane: 

 Clear all of the Heads to Purge checkboxes of the print heads 
that you do not want to purge.  

 Select all of the Heads to Purge checkboxes of the print heads 
that you want to purge.  

 
Figure 144: Purge Pane 

4. In the Sec field, set the time to 2 (seconds). 
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5. Manually open the Manual Purge Valve of one of the print heads 
that you want to purge.  

 
Figure 145: Image of Purge Valves 

 

NOTE: 

Keep your hand on the Manual Purge Valve, ready to close it off. 

 

6. Click the Purge button; the green indicator light appears during 
purging.  

7. After 1.5 seconds, close the Manual Purge Valve; you should see 
ink coming out of the print head. 

 

NOTE: 

Do not leave the Manual Purge Valve open for longer than 2 seconds, and 
most important, not more than the 2 seconds of the purge duration. Otherwise, 
air can get into the system again and you will have to repeat this process. 

 

8. Repeat steps ‎5 - ‎7 for each selected print head. 

9. Reset the purge duration time back to the original setting. 

10. Perform a Nozzle Test. See Performing a Nozzle Test on page 68. 

Degassing Membrane 

 

 
Manual Purge Valve 

Ink Outlet (while performing a 
long purge) 

Ink Filter 

 

 

Print Head 
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4.2 Fixing Bleeding Images 

Bleeding has occurred when:  

 There is a lack of sharpness in the edges of the printed white layer. 

 One color runs into another color. 

 Ink pulls are created. 

 There is fogginess around the image. 

  More registration 

 The image is pale. 

 There is a hard feel on the final size. 

 Smell. 

 The image cracks when the garment is stretched. 

 There is yellow on white shirts. 

When bleeding has occurred with an image, first determine whether 
this is happening to all images or only to specific images. 

When a specific image is bleeding, perform each of the following 
solutions until the problem is solved: 

1. Increase the Fixation Spray Amount – The fixation spray increases 
the adhesiveness of the image to the garment and prevents it from 
being absorbed, thus producing a smooth and vivid image.  

2. Decrease the Ink Percentage – Examine the ink percentage that 
was used to prepare the image file to determine if it was too high. 
How do you know?? 

3. Verify that 100% Black is used – Make sure that the black 
separation that was used to prepare the file is 100% black and not 
a composite of CMYK. How do you do this?? 

 

NOTE: 

A composite of 100% black, 35% cyan and 35% magenta can also be used. 
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 To increase the fixation spray amount: 

1. From the job queue, double-click the target job; the File Details 
window appears.  

 
Figure 146: File Details Window 

2. Increase the number in the Spray Amount box. 

3. Click OK to save the new setting. 

 

NOTE: 

This change in spray amount will only be applied on this image. For Setup 
spray changes, use the Media Database window. 
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4.3 Manually Filling the Secondary Ink 

Tanks 

After manually performing a purge or when there is a malfunction in the 
system, the system can indicate low ink levels. In such cases, press 
the Ink Reset button in the Technician/Head Properties window. 

If the ink levels are not full and you have Technician privileges, you can 
manually fill the Secondary Ink Tanks from the Technician window.  

 To manually fill the Secondary Ink Tanks: 

1. Verify that the ink bottles are full. 

2. From the Main Window, click Maintenance > Technician; the 
Technician window appears. 

 
Figure 147: Technician Window 

3. Click the Ink Reset button; the ink pumps pump ink to the empty 
Secondary Ink Tank(s) and shut off after ten seconds, even if the 
tank(s) are not yet full.  
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4. View the Ink Level icons in the Technician window. 

a. If the icons indicate that the Secondary Ink Tank(s) are not 

full, click the Ink Reset button again. 

b. If the icons still indicate, repeat step ‎a until the system no 
longer pumps ink, indicating that the Secondary Ink Tanks 
are full. 

 

NOTE: 

After resetting the ink 2-3 times, the Secondary Ink Tank should be full (if 
working properly). If the Secondary Ink Tank is not yet full, contact your local 
distributor. 
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4.4 Correcting a Malfunctioning Vacuum 

System 

Negative Air (vacuum) is applied to the ink system to prevent unwanted 
ink from dripping out of the print heads.  

You can view the Negative Air status at the bottom of the LCD 
Maintenance Monitor window. The status is presented as a negative 
number and in the following colors: 

 Green – There is sufficient vacuum pressure in the system. 

 Red – There is insufficient vacuum pressure in the system. 

When the Negative Air status number color appears as red for an 
extended period of time, we suggest that you perform the corrective 
procedure. 

 To correct a malfunctioning vacuum system: 

1. Turn off the power to the system. See Activating the Printer on 
page 57. 

2. Turn back on the power to the system. 

3. Examine the Negative Air status number in the LCD Maintenance 
Panel window: 

 If the number color is green, resume printing. 

 If the number color is red, contact you local Kornit agent. 



216  Kornit Breeze User Guide 

Last printed: 1/11/2012 4:38:00 PM 

Last saved: 1/11/2012 4:38:00 PM 

4.5 Cleaning the Encoder – Technician 

The Encoder should be cleaned by the technician only, when the axes 
do not function according to expectation.  

 To clean the Encoder: 

1. From the Operator window or the LCD Maintenance Panel, lower 

the maintenance tray to the Down position. 

2. Lift up the Front Hood (automatically shutting down the system).  

3. Using lint-free wipes, gently wipe the encoder strip along its entire 
exposed length, both on the top side and on the bottom side. 

 
Figure 148: Encoder Strip 

4. Manually move the print head assembly to the left side of the Scan 
axis and gently wipe the remainder of the encoder strip. 

5. Lower down the Front Hood; the system restarts and automatically 
performs initialization. 
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4.6 Defining Conflicting Z Motor 

Parameters 

The system automatically compares the parameters that were burnt 
into the Main Board with the parameters defined in the Parameters file 
(MachineConfig.enc). 

When any of the parameters of Main Board and the Parameters file are 
not in agreement, the Z Motor Parameters Conflict window appears 
and the conflicting parameters appear in red. 

 

 To define conflicting Z Motor parameters: 

1. Select one of the following options: 

 Keep current machine parameters (recommended) 

 Set parameter handling for the machine. 

2. Select Proceed. 
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5 Daily Maintenance Checklist (for 
Work Day) 
Daily Maintenance Checklist (for Work Day) summarizes the actions 
that you should perform when starting and completing a work day. 

For a more complete description of daily maintenance activities, see the 
following document:  
62-PMNT-0003-Breeze Preventative Maintenance Guide. 

Copy and complete this checklist for your daily records.  

 Date:  

Step Start of Day Description Completed 

1 Verify that the ink bottles are not empty.  

2 Verify that the spray tank is full.  

3 Verify that the waste ink tank is not almost full.  

4 Clean printing pallet, bellows, pallet frame, sleeve-
protector panel, and surfaces around the printing pallet. 

 

5 Clean the ink wipers.  

6 Clean the print head orifice plates.  

7 Power On the printer and turn on the computer.  

8 Access the interface.  

9 Perform print head purge/purge and wipe  

10 Print nozzle tests (write and store test date and time).  

 End of Day Description  

1 Clean maintenance tray and wipers.  

2 Clean the bottom frame of the print head carriage.  

3 Clean the print head orifice plates.  

4 Clean the ink wipers  

5 Print nozzle tests (write and store test date and time).  

6 Close the application.  

7 Power Off the printer and turn off the computer  

Table 1: Daily Maintenance Checklist (for work day)  
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6 Daily Maintenance Checklist (for 
Work Shift) 
Daily Maintenance Checklist (for Work Shift) summarizes the actions 
that you should perform when starting and completing a work day. 

For a more complete description of daily maintenance activities, see the 
following document:  
62-PMNT-0003-Breeze Preventative Maintenance Guide. 

Copy and complete this checklist for your daily records.  

 Date:  

Step Start of Shift Description Completed 

1 Verify that the ink bottles are not empty.  

2 Verify that the spray tank is full.  

3 Verify that the waste ink tank is not almost full.  

4 Clean printing pallet, bellows, pallet frame, sleeve-
protector panel, and surfaces around the printing pallet. 

 

5 Clean the ink wipers.  

6 Clean the print head orifice plates.  

7 Power On the printer and turn on the computer.  

8 Access the interface.  

9 Perform print head purge/purge and wipe  

10 Print nozzle tests (write and store test date and time).  

 End of Shift Description  

1 Clean maintenance tray and wipers.  

2 Clean the bottom frame of the print head carriage.  

3 Clean the print head orifice plates.  

4 Clean the ink wipers  

5 Print nozzle tests (write and store test date and time).  

6 Close the application.  

7 Power Off the printer and turn off the computer  

Table 2: Daily Maintenance Checklist (for work shift)  
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7 Weekly Maintenance Procedures 
The following procedures must be performed once a week. 

For a more complete description of weekly maintenance activities, see 
the following document:  
62-PMNT-0003-Breeze Preventative Maintenance Guide. 

 To perform weekly maintenance: 

1. Clean the maintenance tray, the pipe running from the tray to the 
waste container, and the wipers.  

a. From the Operator window, click Down to lower the 
maintenance tray.  

b. Open the Front Hood; the interlock shuts down the printer. 

c. Move the print head carriage to the left side of the printer.  

d. Pour warm water onto the maintenance tray and use lint-free 
wipes to wipe away all ink particles from the tray and the 
wipers. 

e. Ensure that the waste ink tube is unblocked. If blocked, use a 
rigid wire to push through the blockage, allowing the ink to 
drain freely. 

f. Clean the ink wipers with hot water. 

g. Close the Front Hood; the printer automatically begins 
initialization. 

h. Wait for completion and perform Purge and Wipe. 

2. Clean the scan-axis encoder scale. 

3. Perform a general cleanup: 

a. Clean all machine covers and bellows, ensuring that all color 
drops, spray drops, dust and lint are removed. 

b. Clean the area around the machine to remove all lint. 
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